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Introducing Quark Publishing
Platform administration tasks

Administering a Quark® Publishing Platform™ environment requires extensive

hardware and software maintenance in addition to the controls in Quark Publishing

Platform. This guide describes tasks administrators perform for security, system

configuration adjustments, and integration with other systems. For information

about administrating in the Quark Publishing Platform interface, see A Guide to

Quark Publishing Platform. For information about installing Quark Publishing

Platform software, see the Quark Publishing Platform ReadMe.
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Deploying Quark Publishing
Platform Server to external server
containers

You can deploy Quark Publishing Platform Server in an external Tomcat installation

and in IBM WebSphere.

Setting up environment variables

To prepare for deployment, set the following environment variables.

If you are deploying Quark Publishing Platform Server as a service, you must set
these as global system environment variables.

MAGICK_HOME: [ImageMagick installation directory]\bin•

MAGICK_FILTER_MODULE_PATH: %MAGICK_HOME%/modules/filters•

MAGICK_CODER_MODULE_PATH: %MAGICK_HOME%/modules/coders•

Configuring the JVM

Regardless of which application server you are using, you must increase the memory

available to the JVM in Tomcat and IBM WebSphere as follows to accommodate

Quark Publishing Platform Server:

Set the minimum Java heap memory to 2048MB.•

Set the minimum PermGenSpace to 512MB.•

Preparing the EAR file for deployment

A Platform EAR build consists of the following things:

Platform Server Configuration files.•

Binaries of dependencies.•

A tool to generate the JEE EAR file.•

The following folders are included in an EAR build:

conf: Contains Platform Server configuration files.•
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database: Contains database creation, update, and support files.•

ImageMagick: Contain ImageMagick application binaries.•

Jaws: Contains JAWS application binaries.•

DITA-OT-2.4.6: Contains DITA OT binaries.•

publishing: Contains configuration and resource files for the Quark Publishing•
Platform framework.

The Platform Server application consists of following modules:

admin.war: The Quark Publishing Platform administration Web application.•

workspace.war: The Quark Publishing Platform workspace Web application.•

webservices.war: The Quark Publishing Platform Server Web services module.•

rest.war: The Quark Publishing Platform server REST interface module.•

messaging.war: The HTTP-based messaging interface.•

qxpsm.war: QuarkXPress Server Manager.•

qxpsmadmin.war: The QuarkXPress Server Manager administration Web•
application.

pluginwiris_engine.war: The wiris plugin mathematical equation support.•

To generate the Quark Publishing Platform Server JEE enterprise archive:

Copy the Quark Publishing Platform EAR build to the computer on which the1.

application server is running.

Update the configuration files (including “Database.properties”,2.

“managerconfig.xml”, “PluginContext.xml”, and “QLA.properties.xml”) as

described in “Quark Publishing Platform Server — Manual configuration.”

Update the values for the JMX Agent username and password in3.

“serverApp.properties”. The values for username and password will be the

same used to log on to WebSphere’s admin console.

Run RunEARUpdater.bat. A “For Deployment” folder is created, containing a4.

deployable Quark Publishing Platform EAR file.

Deploying in IBM WebSphere

To deploy in IBM WebSphere (Supported version is 9.0.0.0):

Copy the “qpp” folder from “For Deployment” to the working directory of the1.

application server instance where the EAR file will be deployed. For IBM

WebSphere, this is typically the folder corresponding to the target profile.

To deliver resources (Quark Publishing Platform or otherwise) to IBM FileNet,
add the following to the end of the [working
directory]\properties\wsjaas.conf file:

FileNetP8WSI {
com.filenet.api.util.WSILoginModule required;

};
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Launch the IBM WebSphere application server console by navigating to2.

http://localhost:port/ibm/console.

Under Applications, click New Application.3.

Click New Enterprise Application.4.

Under Path to the new application, click Choose File and then select the .ear5.

file in the “For Deployment” folder. (For more information, see “Preparing the

EAR file for deployment.”)

Under Preparing for the application installation, click Next.6.

Click Next for steps 1, 2, 3, and 4. Leave all settings at their default.7.

Click Finish for step 5.8.

Click Save.9.

Navigate to Applications > Application Types > WebSphere enterprise10.

applications and click qpp-ear-updater-13.2.jar again.

Under References, click Shared library references.11.

Check the box next to qpp-ear-updater-13.2.jar, then click Reference shared12.

libraries.

On the next screen, click New.13.

Select any name. As classpath, enter the relative paths of the Platform14.

publishing and ext folders.

For example, to target this directory:

C:\ProgramFiles\IBM\WebSphere\AppServer\profiles\AppSrv01\qpp\
publishing
...you would enter ./qpp/publishing and ./qpp/ext

Click Apply or OK to save the settings.15.

Assign this library reference to the qpp-ear-updater-13.2.jar application.16.

Start the qpp-ear-updater-13.2.jar Web application.17.

Click on the QPP EAR shown in the list, then select Class loading and update18.

detection to change class loading configuration.

Navigate to Applications > Application Types > WebSphere enterprise

applications:

Change class loader order to Classes loaded with local class loader first•

(parent last) option.

Change WAR class loader policy to Class loader for each WAR file in•

application option.

Click Apply and save the changes to the master configuration.•

Restart the QPP ear.•
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To verify the installation, navigate to the following URLs:19.

http://localhost:9080/admin
http://localhost:9080/workspace

Deploying in external Tomcat

Developed by the Apache Software Foundation, Apache Tomcat™ serves as the

standard reference implementation for Java™ Servlet and JavaServer™ Pages

technologies. Tomcat™ is a servlet container for managing Web applications.

When you install the standalone version of Quark Publishing Platform Server, the

installation embeds an instance of Tomcat in the Quark Publishing Platform Server

Java Virtual Machine (JVM™) to manage Quark Publishing Platform Web

applications, such as Quark Publishing Platform Web Client.

However, if you are already running a Tomcat server for other Web applications,

and you want the Quark Publishing Platform Web applications to use your existing

Tomcat server, you can deploy Quark Publishing Platform Server in this instance of

Tomcat. Deploying Quark Publishing Platform Server in your existing (that is,

external) Tomcat server means you don’t have to run a separate Quark Publishing

Platform Server process on the server computer. If you want to deploy Quark

Publishing Platform Server in your external Tomcat, you can use a separate build

located in “Server (External Web Container)” in your software package.

Requirements and setup

Quark Publishing Platform Server requires JAVA 8 and Apache Tomcat 7.0.77 or

above to be configured as a Web server. The computer on which Tomcat is running

should be a 64-bit computer. You can add Quark Publishing Platform Server to an

existing Tomcat installation.

Setup Tomcat running on Windows

The existing Apache Tomcat installation folder in the steps below is TOMCAT_HOME

To deploy Quark Publishing Platform in an external Tomcat installation created by

the Tomcat installer or deployed with binaries:

Copy the [QPP_BUILD]/qpp folder to the [TOMCAT_HOME] folder.1.

Copy the contents of the [QPP_BUILD]/webapps folder to the2.

[TOMCAT_HOME]/webapps folder.

If Tomcat is installed with the installer, in the3.

[TOMCAT_HOME]/qpp/publishing/AS-Busdoc.xslt,

[TOMCAT_HOME]/qpp/publishing/BusDoc2QCD.xslt,

[TOMCAT_HOME]/qpp/publishing/BusDoc2QXPS.xslt and

[TOMCAT_HOME]/qpp/publishing/SmartDoc2QXPS.xsltfiles, update the

following paths as given below:

<xsl:include href=”./qpp/publishing/xref-dita-anchors.xslt”/>
<xsl:include href=”./qpp/publishing/AS-StyleSheets.xslt”/>
<xsl:include href=”./qpp/publishing/AS-Transformations.xslt”/>
<xsl:include
href=”./qpp/publishing/BusDocsWordTableStyles.xslt”/>
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If Tomcat is deployed with binaries, in the4.

[TOMCAT_HOME]/qpp/publishing/AS-Busdoc.xslt,

[TOMCAT_HOME]/qpp/publishing/BusDoc2QCD.xslt,

[TOMCAT_HOME]/qpp/BusDoc2QXPS.xslt and

[TOMCAT_HOME]/qpp/publishing/SmartDoc2QXPS.xslt files, update the

following paths:

<xsl:include href=”../qpp/publishing/xref-dita-anchors.xslt”/>
<xsl:include href=”../qpp/publishing/AS-StyleSheets.xslt”/>
<xsl:include href=”../qpp/publishing/AS-
Transformations.xslt”/>
<xsl:include
href=”../qpp/publishing/BusDocsWordTableStyles.xslt”/>

In the[TOMCAT_HOME]/qpp/publishing/SmartDoc2QXPS.xslt file, update5.

the following paths:

<xsl:include
href=”../qpp/publishing/SmartDocTransformations.xslt”/>
<xsl:include
href=”../qpp/publishing/SmartDoc_xref_anchors.xslt”/>
<xsl:include
href=”../qpp/publishing/SmartDoc_StyleSheets.xslt”/>
In the [TOMCAT_HOME]/qpp/conf/ServerApp.properties file:6.

Enter the webServer.port value you configured for Tomcat (8080 for•

example).

Set the webServer.embeddedWebContainer value to false.•

In the [TOMCAT_HOME]/qpp/conf/ManagerConfig.xml file:7.

Enter the IP address or hostname of the QuarkXPress Server in the name•

element of the connectioninfo section.

Enter the port for QuarkXPress Server in the port element.•

Keep in mind that Tomcat and the QuarkXPress Server should not be running
on the same port if QuarkXPress Server and Tomcat are running on the same

machine.

In the [TOMCAT_HOME]/qpp/conf/Qla.properties file:8.

Set the host name, port number, and serial number of your instance of the•

QLA Server.

To configure the database, in the9.

[TOMCAT_HOME]/qpp/conf/Database.properties file edit/add the

following values:

For Oracle:•

qpp.jdbc.driverClassName = oracle.jdbc.driver.OracleDriver
qpp.jdbc.url =
jdbc:oracle:thin:@<hostname><:portnumber><:oracle_sid>
qpp.jdbc.userName = QppOracleDB
qpp.jdbc.password = QppPassword

For SQL Server:•

qpp.jdbc.driverClassName =
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com.microsoft.sqlserver.jdbc.SQLServerDriver
qpp.jdbc.url =jdbc:sqlserver://<your-host-
name>\\<instanceName>;databaseName=qppdb
qpp.jdbc.userName = QppMSSQLDB
qpp.jdbc.password = QppPassword

Edit the [TOMCAT_HOME]/qpp/conf/PluginsContext.xml file by replacing10.

the default entry of the HSQL Dao context with the required database Dao

context:

For Oracle:•

<import
resource=”classpath:com/quark/qpp/common/dao/rdbms/oracle/
OracleDaoContext.xml”/>

For SQL Server:•

<import
resource=”classpath:com/quark/qpp/common/dao/rdbms/sqlserv
er/SqlServerDaoContext.xml”/>

Set the following global environment variables on the machine:11.

MAGICK_HOME : [Tomcat_Home]\[Installation path of Platform•

Server\ImageMagick\bin.

MAGICK_FILTER_MODULE_PATH : %MAGICK_HOME%/modules/filters.•

MAGICK_CODER_MODULE_PATH : %MAGICK_HOME%/modules/coders.•

Open the [TOMCAT_HOME]/conf/catalina.properties file and add the12.

following line:

Shared.Loader
:${catalina.home}/qpp/conf,${catalina.home}/qpp/lib/*.jar,

${catalina.home}/qpp/publishing, ${catalina.base}/qpp/ext

Open the [TOMCAT_HOME]/conf/catalina.properties file and search for13.

org.apache.catalina.startup.TldConfig.jarsToSkip= and update:

org.apache.catalina.startup.TldConfig.jarsToSkip=a*.jar,b*.jar
,c*.jar,d*.jar,e*.jar,f*.jar,g*.jar,
h*.jar,i*.jar,k*.jar,l*.jar,m*.jar,n*.jar,o*.jar,p*.jar,q*.jar
,r*.jar,s*.jar,t*.jar,u*.jar,v*.jar,w*.jar,x*.
jar,y*.jar,z*.jar,ja*.jar,jc*.jar,jd*.jar,je*.jar,ji*.jar,jn*.
jar
If Tomcat is installed with the installer:14.

Launch the Tomcat monitor. In the JAVA tab, set CATALINA_OPTS under Java

Options:

If Platform Server is running with Oracle database:•
Doracle.jdbc.J2EE13Compliant=true 

For integration of LDAP (or give absolute path):•
Djava.security.krb5.conf=./qpp/conf/krb5.conf

For Java PermGen memory space: XX:MaxPermSize=256m•

If Tomcat is deployed with binaries:15.

Open the [TOMCAT_HOME]/bin/catalina.bat file and set the following

parameters:
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JRE_HOME=C:\Program Files\Java\jdk1.8.0_131JAVA_OPTS=-•
server -Xmx2048m -XX:MaxPermSize=128m

CATALINA_OPTS=-Doracle.jdbc.J2EE13Compliant=true -•
Djava.security.krb5.conf=../qpp/conf/krb5.conf

Launch the Tomcat monitor. In the JAVA tab, set the following parameters:16.

Initial memory pool=1024 MB.•

Maximum memory pool=2048 MB.•

Server startup and verification

After you install Quark Publishing Platform Server with Tomcat and specify the port

for Quark Publishing Platform Server access, you can start Quark Publishing

Platform Server and verify your configuration. Quark Publishing Platform Server

and Tomcat are tied together. To start and stop Quark Publishing Platform Server,

you need to start and stop Tomcat.

To confirm Quark Publishing Platform Web Client access, in you browser’s address

field enter: http://[machineName]:[webServerPort]/workspace

To confirm Quark Publishing Platform Web admin access, in you browser’s address

field enter: http://[machineName]:[webServerPort]/admin

QuarkCopyDesk, QuarkXPress, Quark Publishing Platform Client, Quark Publishing
Platform Web Client, and Quark Publishing Platform Script Manager use the Tomcat

port to log on to Quark Publishing Platform server.

Deploying Quark Publishing Platform Server in multi-server deployment

A Quark Publishing Platform multi-server cluster is a set of Quark Publishing

Platform Server installations that has been configured to use a common database,

shared asset repository, and message queue. A multi-server cluster offers the

following advantages:

It lets you serve a larger number of requests by adding hardware.•

It lets you add active load balancing.•

It provides redundant and reliable setup.•

Failure of any specific instance in a cluster does not result in complete service•

outage. Only a fraction of active sessions are affected by an instance failure, and

subsequent requests can be routed to an available active Quark Publishing

Platform Server instance.

It is transparent to clients that communicate with the load-balancing HTTP•

server.

To load-balance requests, you must have an HTTP server and any HTTP load

balancer that supports the “sticky session” feature. The following HTTP servers have

been tested as load-balancing servers:

Microsoft IIS 7 with the latest version of the IIS Tomcat connector.•

Apache 2.2 with the latest version of the JK Tomcat Connector for Apache 2.2.•
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Apache 2.2 with built in mod_proxy and mod_proxy_balancer DSO modules of•

the Apache 2.2.

HA PROXY on Redhat Linux 7.x•

Only requests routed through an HTTP load balancer are load-balanced among
different instances. Requests to a specific instance are always served by that

instance, irrespective of its existing load.

RMI clients must connect directly to a specific server instance.

Configuring cluster server instances or nodes

The Quark Publishing Platform Server can be deployed as a standalone server or in

an external Tomcat using the database on the initial computers, which are called

nodes of the Platform multiserver cluster. The first step in setting up cluster servers

is to set up a Quark Publishing Platform Server database for Oracle or MS SQL Server.

Platform Server deployed as a standalone server to work as nodes

On each Quark Publishing Platform Server computer:

Open the “ActiveMQ.xml” file located in the qpp/conf folder.1.

In the “ActiveMQ.xml” file, uncomment and add the network connectors to2.

integrate the server instance’s message queue with one or more server instances

in the cluster, where qpp-node-N is the name of a computer where another

instance of Quark Publishing Platform Server is deployed:

There must be one connector for each node of the cluster except the node itself.

Here there is a cluster of three nodes:

Node 1 should contain the following entry:

<networkConnectors>
<networkConnector 
dynamicOnly=”true”

duplex=”false”
name=”node1-1”

networkTTL=”1”
uri=”static:(tcp://qpp-Node2:61401)”/>

<networkConnector 
dynamicOnly=”true”

duplex=”false”
name=”node1-2”

networkTTL=”1”
uri=”static:(tcp://qpp-node3:61401)”/>

</networkConnectors>
Node 2 should contain the following entry:

<networkConnectors>
<networkConnector 
dynamicOnly=”true”

duplex=”false”
name=”node2-1”

networkTTL=”1”
uri=”static:(tcp://qpp-Node1:61401)”/>

<networkConnector 
dynamicOnly=”true”
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duplex=”false”
name=”node2-2”

networkTTL=”1”
uri=”static:(tcp://qpp-node3:61401)”/>

</networkConnectors>
Node 3 should contain the following entry:

<networkConnectors>
<networkConnector 
dynamicOnly=”true”

duplex=”false”
name=”node3-1”

networkTTL=”1”
uri=”static:(tcp://qpp-Node1:61401)”/>

<networkConnector 
dynamicOnly=”true”

duplex=”false”
name=”node3-2”

networkTTL=”1”
uri=”static:(tcp://qpp-node2:61401)”/>

</networkConnectors>
The name of the connectors (e.g. node1-1 & node1-2) should be unique
throughout the cluster.

In the “ActiveMQ.xml” file, uncomment the transport connector(s) to integrate3.

the server instances’ message queues.

Should look like:

<transportConnector 

uri=”tcp://localhost:${jms.openWirePort}?wireFormat.maxInactiv
ityDuration=0” 

updateClusterClients=”true” 
rebalanceClusterClients=”true”
updateClusterClientsOnRemove=”true”/>   

<transportConnector 

uri=”tcp://${server.machinename}:${jms.openWirePort}?wireForma
t.maxInactivityDuration=0”/>
Open the “web.xml” file of the workspace and admin webapps, located in the4.

WEB-INF folder for each webapp and uncomment the SessionResetFilter to

handle sessions in case of node failure.

<filter>
<filter-name>SessionResetFilter</filter-name>
<filter-
class>com.quark.web.security.servlet.SessionResetFilter</filte
r-class>
<init-param>
<param-name>jvmRoute</param-name>
<param-value>qpp1</param-value>
</init-param>
<init-param>
<param-name>sessionCookieName</param-name>
<param-value>JSESSIONID</param-value>
</init-param>
<init-param>
<param-name>sessionInitUrls</param-name>
<param-value>
/workspace/reconnectUser.qsp
/workspace/login.qsp
</param-value>
</init-param>
</filter>
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<filter-mapping>
<filter-name>SessionResetFilter</filter-name>
<url-pattern>/*</url-pattern>
</filter-mapping>
In the “ServerApp.properties” file located in the [QPP Server]/conf folder,5.

assign a unique value to server.id.prefix, identifying the server instance.

In the “ServerApp.properties” file located in the [QPP Server]/conf folder,6.

assign the IP of the machine to “server.machinename”, identifying the server

instance.

In the “server.xml” file located in the [server-path]/conf folder, assign a7.

unique value to the jvmRoute attribute of the <Engine> tag.

<Engine name=”Catalina” defaultHost=”localhost”
jvmRoute=”node1”>
The value of jvmRoute in the “web.xml” file (the file being edited in step 4)
and in the “server.xml” file should be the same.

To allow the storage of session cookies at the application root, edit the8.

“context.xml” file located in the server-path]/conf folder, as follows:

<Context sessionCookiePath=”/” reloadable=”false”
crossContext=”true” swallowOutput=”true” >

This change is required for workflows involving SOAP based clients like Quark
XML Author. For Web based applications like Quark Author Web Edition, the

session cookie should be stored at the webapps path, so there is no change

needed in the “context.xml” file.

Rename the “services” folder, located at9.

{TOMCAT_HOME}/webapps/webServices/WEB-INF, to “services_old”.

Rename the “serviceArchivesMultiServer” folder, located at10.

{TOMCAT_HOME}/webapps/webServices/WEB-INF, to “services”.

In the “ServerStartup.bat” file located in the server installation folder, add the -11.

Dspring.profiles.active=multiserver to run the server in cluster mode:

java -Xmx2048m -XX:MaxPermSize=256m 
-classpath “%JavaClassPath%” 
-Dspring.profiles.active=multiserver 
-Doracle.jdbc.J2EE13Compliant=true 
-Djava.security.krb5.conf=conf/krb5.conf 
-Djava.endorsed.dirs=”endorsed” 
-

Djavax.xml.stream.XMLInputFactory=com.ctc.wstx.stax.WstxInputF
actory com.quark.qpp.Server PluginsContext.xml
In the “wrapper.conf” file located in the server installation folder, uncomment12.

the following under the Java Additional Parameters section:

wrapper.java.additional.7=-Dspring.profiles.active=multiserver

Repeat the above steps for all Quark Publishing Platform nodes.

Clear your browser cookies before you start your work.13.

Perform the steps to flush caches across all server instances as described in the14.

following section, “Configuring server caches flushing mechanism“.
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Configuring server caches flushing mechanism

Platform Server provides two mechanisms to flush caches across all server instances

in case of an update:

Notification based - This mechanism clears the cache asynchronously. The•

Notification based cache flushing is accomplished by publishing of a message of

type CACHE with property FLUSH_INTERCEPTOR. This is the default configured

mechanism.

REST request based - This mechanism clears the cache synchronously. The REST•

based mechanism makes an HTTP request to every peer node to trigger its cache

flushing:
http://{peerNode}:61400/rest/service/xcache/flush/{interceptor
Name}. This mechanism is not the default configuration, but you may configure

it if needed.

In order to configure REST based cache flushing mechanism, make the following

changes:

Open the “CacheManager.xml” file found in1.
{install_path}/Server/lib/qpp-server-common-{version}.jar

Comment the asyncRemoteMessenger and uncomment the2.

synchronousRemoteInvoker. Inject this bean instead of

asyncRemoteMessenger in baseCacheFlushingInterceptor.
<bean id=”synchronousRemoteInvoker”

class=”com.quark.qpp.common.caching.SynchronousRemoteInvoker”>
<property name=”remoteHosts” value=”${server.peer.url}”/>
<property name=”httpContext”

value=”${server.cache.remoteFlush.context}”/>
</bean>

<!— <bean id=”asyncRemoteMessenger”  
class=”com.quark.qpp.core.messaging.service.impl.AsyncRemoteMe
ssenger”>

<property name=”messagePublisher” ref=”messagePublisher”/>
</bean> —>

Find the baseCacheFlushingInterceptor and inject the3.

synchronousRemoteInvoker bean in the flushinginterceptor:

<bean id=”baseCacheFlushingInterceptor”
class=”com.quark.qpp.common.caching.BaseCacheFlushingAdvice”
abstract=”true”>

<property name=”remoteInvoker”
ref=”synchronousRemoteInvoker”/>
</bean>

Save and close the file.4.

In the “ServerApp.properties” file located in the [QPP Server]/conf folder,5.

uncomment the following:

# Uncomment following properties to configure QPP cluster with
synchronous cache update 
# Set comma separate URIs of peer server instances which are
part of Cluster except the node itself 
server.peer.url=http://{peerHostN 1}:61400,http://{peerHostN



DEPLOYING QUARK PUBLISHING PLATFORM SERVER TO EXTERNAL SERVER CONTAINERS

Quark Publishing Platform 2015 March 2018 Update System Administration Guide | 13

2}:61400 

# Http context which may be used to invoke cache flushing 
server.cache.remoteFlush.context=rest/service/xcache/flush
For each node open the “rest-servlet.xml” file located in the [QPP6.

Server]/webapps/rest/WEB-INF folder, uncomment the following:

<!— Following code should be uncommented for synchronous REST
based cache flushing in clustered environment.

This enables “RemoteFlushController” which handles HTTP
requests from remote peers for flushing the cache. —>
<context:component-scan base-
package=”com.quark.qpp.common.caching”/>
Restart the server.7.

Platform Server deployed in external Tomcat

On each Quark Publishing Platform Server computer:

Deploy a standalone instance of Quark Publishing Platform Server in external1.

Tomcat, using the database on the initial computer.

Open the “ActiveMQ.xml” file located in the qpp/conf folder and add network2.

connectors to integrate the server instance’s message queue with one or more

server instances in the cluster, where qpp-node-N is the name of a computer

where another instance of Quark Publishing Platform Server is deployed:

Add these network connectors the same way you added them in Step 2 of the
section: “Platform Server deployed as a standalone server to work as nodes“.

Uncomment the transport connector(s) in the “ActiveMQ.xml” file to integrate3.

the server instances’ message queues with the IP address and name of the server

instances in the cluster.

<transportConnector
uri=”tcp://localhost:${jms.openWirePort}?wireFormat.maxInactiv
ityDuration=0”

updateClusterClients=”true”
rebalanceClusterClients=”true”
updateClusterClientsOnRemove=”true”/>

<transportConnector
uri=”tcp://${server.machinename}:${jms.openWirePort}?wireForma
t.maxInactivityDuration=0”/>

In the “ServerApp.properties” file located in the [QPP Server]/conf folder,4.

assign a unique value to server.id.prefix, identifying the server instance.

In the “ServerApp.properties” file located in the [QPP Server]/conf folder,5.

assign the IP of the machine to server.machinename attribute, identifying the

server instance.

In the “server.xml” file located in the {TOMCAT_HOME}/conf folder, assign a6.

unique value to the jvmRoute attribute of the <Engine> tag.

<Engine name=”Catalina” defaultHost=”localhost”
jvmRoute=”node1”>
Edit the tomcat_home/conf/context.xml file as follows:7.

<Context sessionCookiePath=”/”>
Rename the “serviceArchivesMultiServer” folder, located at8.

{TOMCAT_HOME}/webapps/webServices/WEB-INF, to “services”.
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Edit the “Catalina.bat” file located in the {TOMCAT_HOME}/bin folder. Set the9.

following runtime parameter to run the server in multi-server mode:

Set CATALINA_OPTS=-Dspring.profiles.active=multiserver

If apache tomcat is running as a “service” then add this parameter in the
Apache tomcat monitor under the Java tab in the Java option text field: -
Dspring.profiles.active=multiserver

Open the “web.xml” file of the workspace and admin webapps, located in the10.

{TOMCAT_HOME}/webapps/ WEB-INF folder for each webapp and uncomment

the SessionResetFilter to handle sessions in case of node failure as given

below:

<filter>
<filter-name>SessionResetFilter</filter-name>
<filter-

class>com.quark.web.security.servlet.SessionResetFilter</filte
r-class>

<init-param>
<param-name>jvmRoute</param-name>
<param-value>qpp1</param-value>
</init-param> <init-param>
<param-name>sessionCookieName</param-name>
<param-value>JSESSIONID</param-value>

</init-param>
<init-param>

<param-name>sessionInitUrls</param-name>
<param-value> /workspace/reconnectUser.qsp

/workspace/login.qsp </param-value>
</init-param>

</filter>
<filter-mapping>

<filter-name>SessionResetFilter</filter-name>
<url-pattern>/*</url-pattern>

</filter-mapping>
The value of the <param-value>qpp1</param-value> should be same as that
in the “ server.xml” file of Step 6.

Repeat the above steps for all Quark Publishing Platform nodes.11.

Configuring IIS as an HTTP load balancer

To configure IIS 7 as an HTTP load balancer:

The first step is to deploy the Tomcat connector. For more details on how to do1.

this, see http://tomcat.apache.org/connectors-doc/webserver_howto/iis.html. Create a

new folder named “TomcatConnector,” then put the “isapi_redirect.dll” file

from the Tomcat Connector for IIS build.

Create a new file named “isapi_redirect.properties” in the same folder, and2.

insert the following into the file:

extension_uri=/jakarta/isapi_redirect.dll
log_file=C:\TomcatConnector\Log\isapi.log
# Make sure the directory listed for log files in the
# “isapi_redirect.properties” file exists
log_level=info
worker_file=C:\TomcatConnector\worker.properties
worker_mount_file=C:\TomcatConnector\uriworker.properties

http://tomcat.apache.org/connectors-doc/webserver_howto/iis.html
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Create a new file named “workers.properties” in the same folder, and insert the3.

following into the file, where qpp-node1 and qpp-node2 are the values of the

jvmRoute attribute as specified in the “server.xml” file for each Quark

Publishing Platform Server:

worker.list=TomcatBalancer
worker.TomcatBalancer.type=lb 
worker.TomcatBalancer.balance_workers=qpp-node1,qpp-node2
worker.TomcatBalancer.sticky_session=True
worker.TomcatBalancer.sticky_session_force=True
worker.TomcatBalancer.method=Request
worker.TomcatBalancer.lock=Pessimistic
worker.qpp-node1.type=ajp13
worker.qpp-node1.host=qpp-node1

# This should be the same as the port in the AJP connector
defined
# in the “server.xml” file for the Tomcat server in which
Quark
# Publishing Platform is deployed
worker.qpp-node1.port=61398
worker.qpp-node1.lbfactor=3
worker.qpp-node2.type=ajp13
worker.qpp-node2.host=qpp-node2

# This should be the same as the port in the AJP connector
defined
# in the “server.xml” file for the Tomcat server in which
Quark
# Publishing Platform is deployed
worker.qpp-node2.port=61398
worker.qpp-node2.lbfactor=3
Create a new file named “uriworker.properties” in the same folder, and insert4.

the following into the file:

/admin/*=TomcatBalancer
/admin=TomcatBalancer
/workspace/*=TomcatBalancer
/workspace=TomcatBalancer
/webservices/*=TomcatBalancer
/webservices=TomcatBalancer
/rest/*=TomcatBalancer
/rest=TomcatBalancer
/messaging/*=TomcatBalancer
/messaging=TomcatBalancer
/qxpsmadmin/*=TomcatBalancer
/qxpsmadmin=TomcatBalancer
/favicon.ico=TomcatBalancer
/*=TomcatBalancer
/qxpsm/*=TomcatBalancer
/qxpsm=TomcatBalancer
/pluginwiris_engine/*=TomcatBalancer
/pluginwiris_engine=TomcatBalancer

This file contains the mappings of the URLs that need to be handled by IIS and
forwarded to Quark Publishing Platform Servers.

Using the IIS management console, add a new virtual directory named “jakarta”5.

to your IIS Web site, with the physical path of the directory where you placed

the “isapi_redirect.dll” file.
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Give the virtual directory execute permission. Select the virtual folder, double-6.

click Handler Mappings, and then click Edit Feature Permissions in the

Actions pane. Check Execute in the Edit Feature Permissions dialog box, and

then click OK.

Add an ISAPI filter to the IIS Web site. Select the Web site, double-click ISAPI7.

Filters, and then click Add in the Actions pane. In the Add ISAPI Filter dialog

box, enter a name and the path of the “isapi_redirect.dll” file, and then click

OK.

Configure the ISAPI and CGI Restrictions feature. Navigate to the Server Home8.

screen, double-click ISAPI and CGI Restrictions, and then click Add in the

Actions pane. In the Add ISAPI or CGI Restriction dialog box, enter a name

and the path of the “isapi_redirect.dll” file, check Allow extension path to

execute, and then click OK.

Enable Windows authentication. Navigate to your Web site and double-click9.

Authentication. Right-click Windows Authentication and choose Enable,

disable the other authentication options, and then restart IIS.

To verify the installations, start Quark Publishing Platform Server on all nodes,10.

then access each server using the computer name or IP address and port of the

IIS server. The IIS server should serve and load-balance the request using the

Tomcat connector. You can view the details in the log file identified in the

“isapi_redirect.properties” file.

Configuring Apache Web Server as an HTTP load balancer

To configure Apache Web Server 2.2 with the latest version of the JK Tomcat

Connector for Apache 2.2 as an HTTP load balancer:

The first step is to deploy the Tomcat connector. For more details on how to do1.

this, see http://tomcat.apache.org/connectors-doc/miscellaneous/faq.html. Copy the

“mod_jk.so” file from the Tomcat Connector download location to

{Apache_2.2_installation}/modules.

Open the file {Apache_2.2_installation}/conf/httpd.conf in a text2.

editor and insert the following content:

LoadModule jk_module modules/mod_jk.so
<IfModule jk_module>

JkWorkersFile conf/workers.properties
JkLogFile logs/mod_jk.log

JkLogStampFormat “[%H:%M:%S] “
JkRequestLogFormat “%T”
JkLogLevel error

JkOptions +ForwardKeySize +ForwardURICompat -
ForwardDirectories
<Directory />
AllowOverride All
<Limit GET HEAD POST PUT DELETE OPTIONS>

Order Allow,Deny
Allow from all

</Limit>
</Directory>
JkMount /workspace TomcatBalancer
JkMount /workspace/* TomcatBalancer
JkMount /webservices TomcatBalancer
JkMount /webservices/* TomcatBalancer

http://tomcat.apache.org/connectors-doc/miscellaneous/faq.html
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JkMount /admin TomcatBalancer
JkMount /admin/* TomcatBalancer
JkMount /rest TomcatBalancer
JkMount /rest/* TomcatBalancer
JkMount /messaging TomcatBalancer
JkMount /messaging/* TomcatBalancer
JkMount /qxpsm TomcatBalancer
JkMount /qxpsm/* TomcatBalancer
JkMount /qxpsmadmin TomcatBalancer
JkMount /qxpsmadmin/* TomcatBalancer
JkMount /pluginwiris_engine/*=TomcatBalancer
JkMount /pluginwiris_engine=TomcatBalancer
</IfModule>

Create a file named3.

{Apache_2.2_installation}/conf/workers.properties and add the

following content to it, where qpp-node1 and qpp-node2 are the values of the

jvmRoute attribute as specified in the “server.xml” file for each Quark

Publishing Platform Server:

worker.list=TomcatBalancer
worker.TomcatBalancer.type=lb
worker.TomcatBalancer.balance_workers=qpp-node1, qpp-node2
worker.TomcatBalancer.sticky_session=True

# This should be commented out, if it is not, you cannot
connect to the Apache Web server which 
# acts as the load balancer.
worker.TomcatBalancer.sticky_session_force=True
worker.TomcatBalancer.method=Request
worker.TomcatBalancer.lock=Pessimistic
worker.qpp-node1.type=ajp13

# This should be the IP address of the first QPP node
worker.qpp-node1.host=Server 1
# 8009 is for external tomcat server
# 61398 is for embedded tomcat with QPP
worker.qpp-node1.port=61398
worker.qpp-node1.lbfactor=3
worker.qpp-node2.type=ajp13

# This should be the IP address of the first QPP node
worker.qpp-node2.host=Server 2
# 8009 is for external tomcat server
# 61398 is for embedded tomcat with QPP
worker.qpp-node2.port=61398
worker.qpp-node2.lbfactor=3
Restart Apache 2.2.4.

To verify the installations, start Quark Publishing Platform Server on all nodes,5.

then access each server using the computer name or IP address and port of the

Apache server. The Apache server should serve and load-balance the request

using the Tomcat connector. You can view the details in the log files at

{Apache_2.2_Installation}/logs.

Elasticsearch

A Multi-server deployment can leverage Elasticsearch to avoid regenerating the

search index for each application node of the Platform multiserver cluster.



DEPLOYING QUARK PUBLISHING PLATFORM SERVER TO EXTERNAL SERVER CONTAINERS

18 | Quark Publishing Platform 2015 March 2018 Update System Administration Guide

Download and install Elasticsearch

Download and unzip Elasticsearch v5.4.0 from the following location:1.

www.elastic.co/downloads/elasticsearch

To install Elasticsearch:2.

On Unix: Run bin/elasticsearch.•

On Windows: Run bin\elasticsearch.bat.•

Run curl -X GET http://localhost:9200/•

Configuring Platform server to leverage Elasticsearch

Multi-server deployment can leverage Elasticsearch to avoid regenerating the search

index for each application node of the Platform multiserver cluster.

Perform the following steps on each Quark Publishing Platform Server computer:

Open the “ESIndexingConfig.properties” file located in the [QPP1.

Server]/conf folder.

Specify where Elasticsearch is running:2.

#Comma delimited list of host:tcp_port entries pointing to
Elasticsearch cluster nodes
es.cluster.nodes=platform2k12:9300

The default port for Elasticsearch is 9300.

Specify the name of the index to be used for attributes:3.

es.attribute.index.name=qps-attribute-index
Specify the name of the index to be used for text:4.

es.text.index.name=qps-text-index
In the “ESAttributeIndexSettings.json” file located in the [QPP Server]/conf5.

folder, specify the number of shards and replicas required for the index:

{ “index”:
{“number of shards”:5,
“number of replicas”:1

}
...
}

Configuring Elasticsearch for a multi-server environment

When deployed in a multi-server environment, where each server is running its

own instance of Elasticsearch, the cluster is run in a Master-Child concept. One

instance of Elasticsearch is considered the Master (based on which node was

deployed first) and all other instances are considered Child instances. If the Master

instance is terminated, one of the Child instances becomes the Master.

To configure each Elasticsearch instance as part of a cluster, perform the following

steps for each Elasticsearch deployment:

Open the “elasticsearch.xml” file located in the1.

{Elasticsearch_install_path}/config folder.

http://www.elastic.co/downloads/elasticsearch/
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Specify the name of the cluster:2.

cluster.name: myESclustername
Specify the name of this node:3.

node.name: nameofnode1
Specify the network host name:4.

network.host: mynetworkhost
Identify the other nodes (instances of Elasticsearch) in your cluster:5.

discovery.zen.ping.unicast.hosts: [“nameofnode2”,
“nameofnode3”]
On each Quark Publishing Platform Server computer, in the6.

“ESIndexingConfig.properties” file located in the [QPP Server]/conf folder,

specify the name of the cluster:

#name of the Elasticsearch cluster to which this instance of
Elasticsearch client will connect to.
es.cluster.name=myESclustername

Run Elasticsearch

Running Elasticsearch requires at least Java 8 update 131 or later. The environment

variable JAVA_HOME should be set appropriately.

Elasticsearch can be started using one of the following methods:

Using a batch file:•

To run Elasticsearch in the foreground as a new process, simply run the

“elasticsearch.bat” located in the /bin folder.

As a service:•

To run Elasticsearch in the foreground as a new process, simply run the

“elasticsearch.bat” located in the /bin folder.

To run Elasticsearch as a service, run the “service.bat” located in the /bin folder

with the following commands:

Install Elasticsearch as a service by executing the following command:•

C:\elasticsearch-5.4.0\bin>service.bat install.

After installation, start the Elasticsearch as a service by executing the•

following command: C:\elasticsearch-5.4.0\bin>service.bat
start 

Stop the Elasticsearch service by executing the following command:•
C:\elasticsearch-5.4.0\bin>service.bat stop 

Remove the installed Elasticsearch service (and stop the service if started) by•

executing following command: C:\elasticsearch-
5.4.0\bin>service.bat remove 

Start a GUI for managing the installed service by executing the following•

command: C:\elasticsearch-5.4.0\bin>service.bat manager 

For more information, see
www.elastic.co/guide/en/elasticsearch/reference/current/setup-service-win.html#setup-

service-win

https://www.elastic.co/guide/en/elasticsearch/reference/2.3/setup-service-win.html
https://www.elastic.co/guide/en/elasticsearch/reference/2.3/setup-service-win.html
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For information on configuring Elasticsearch to run with Platform, see Quark

Publishing Platform Sys Admin Guide.

Providing an interface for Elasticsearch

Elasticsearch does not provide a user interface, so Quark offers a 3rd party plugin to

provide one.

To utilize the plugin, perform the following steps for each Elasticsearch deployment:

Copy and paste the head plugin to the1.

{Elasticsearch_install_path}/plugins folder.

To access this user interface:2.

{network host}:9300/_plugin/head/
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Enabling Secure Sockets Layer (SSL)
for Quark Publishing Platform Server

You can configure Quark Publishing Platform with different security options. In

addition to your own network security specifications, you can specify SSL protocol

for your Quark Publishing Platform client applications.

SSL support

You can configure your application server containers and all Quark Publishing

Platform clients to run in secure mode with SSL technology. This section explains

the configuration process.

It is also possible to run Quark Publishing Platform without embedding Tomcat in
JVM. See “Deploying in external Tomcat“ for information about setting up Quark

Publishing Platform without embedding Tomcat.

To manage Web applications in the Quark Publishing Platform environment, Quark

Publishing Platform Server embeds an instance of Apache Tomcat 7.0.77 in its JVM.

The four Web applications in Quark Publishing Platform include Quark Publishing

Platform Web Client, Quark Publishing Platform Console, Quark Publishing

Platform Renderer Manager, and Quark Publishing Platform Web Services.

When you enable SSL, it applies to all Quark Publishing Platform client applications

deployed in Quark Publishing Platform Server.

Enabling SSL in Quark Publishing Platform Server

The instructions below address two scenarios. The “server.xml” file you edit

contains XML tags for both scenarios, which you need to enable or disable by

“commenting” and “uncommenting” specific tags.

To enable SSL for secure HTTP for all Quark Publishing Platform Web applications:

Open the “server.xml” file located in the {install_path}/conf folder.1.

Comment the following tag:2.

<Connector port=”61400”
maxHttpHeaderSize=”8192”maxThreads=”150” minSpareThreads=”25”
maxSpareThreads=”75”enableLookups=”false” redirectPort=”61399”
acceptCount=”100”connectionTimeout=”20000”
disableUploadTimeout=”true” />
Uncomment the following tag:3.

<Connector port=”61399”
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maxHttpHeaderSize=”8192”MaxThreads=”150” minSpareThreads=”25”
maxSpareThreads=”75”enableLookups=”false”
disableUploadTimeout=”true”acceptCount=”100” scheme=”https”
secure=”true”clientAuth=”false” sslProtocol=”TLS” />
Replace 61399 with 61400 (or any port on which Tomcat will be listening for4.

secure connections).

Save and close “server.xml.”5.

On Quark Publishing Platform Server machine, open the command prompt and6.

execute the following command:

%JAVA_HOME%\bin\keytool -genkey -alias tomcat -keyalg RSA

Provide the details in the prompts. Password should be changeit.7.

Restart the Quark Publishing Platform Server.8.

Access the Admin webpage: https://servername:61399/admin9.

This configuration creates one keystore with a private and public key pair. This
is a self sign certificate.

For more information on SSL configuration, including the use of a Certificate10.

Authority, please see the Apache Tomcat SSL information here:
url:https://tomcat.apache.org/tomcat-7.0-doc/ssl-howto.html

This change means Quark Publishing Platform client applications can use HTTPS.
For example, the URL for a Quark Publishing Platform Web Client user would be as

follows: https://[server name]:61399/workspace.

Configuring Platform clients to log on to an SSL enabled Server

macOS QuarkXPress and QuarkCopyDesk users must fetch a SSL certificate from1.

Quark Publishing Platform Server before they can log on. To do so, each user

should launch Terminal and run the following command, substituting the IP

address of the Quark Publishing Platform Server computer for [server name]:

echo | openssl s_client -connect[server name]:443 > [server
name].pem
for El-Capitan and Sierra MAC OS the command is:

echo | openssl s_client -connect[server name]:[Port] -
servername[server name] > [server name.pem
This command retrieves a copy of the server certificate named “[server

name].pem”. Put this file in the ~/Library/Application
Support/Quark/QPP/Certificates folder (or, if you have customized the

plist file at ~/Library/Application Support/Quark/QPP/[QPP
Framework Version], put the file there).

If the “Quark Publishing Platform” and “Certificates” folders do not already
exist at the above locations, create them there manually.

Quark Publishing Platform clients running on Windows do not require a server-
based SSL certificate.

Verifying and using SSL

To verify and use SSL:
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Start the Quark Publishing Platform Server.1.

Test Quark Publishing Platform Web Client access by entering the following:2.

https://[machine IP/name]:61399/workspace.
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Quark Publishing Platform Server —
Manual configuration

You can change the default configuration after you install Quark Publishing

Platform Server. In addition to setting parameters with JConsole while Quark

Publishing Platform Server is running, you can adjust settings in different .xml files

and .properties files. You can also adjust memory allocation for your JVM

configuration.

Editing “ServerApp.properties”

To edit “ServerApp.properties”:

Open the “ServerApp.properties” file in the [QPP Server]/conf folder.1.

Set the jms.openWirePort value to the port number opened for JMS2.

communication via the OpenWire protocol. Java clients such as Quark

Publishing Platform Script Manager connect to this port to listen to server

notifications.

Set the webServer.port value to the port number on which Tomcat listens for3.

HTTP connections. Quark Publishing Platform Web Client and SOAP clients

connect through this port. The value should be set to that specified for the

HTTP connector in the Tomcat “server.xml” file.

Set the socketStreaming.port value to the port number to be used for file4.

transfer (upload/download).

To bind Quark Publishing Platform Server to a particular IP address, set the5.

server.machinename value to that IP address and set

server.bindtoip=true. Or, if you have multiple network cards and you want

to bind Quark Publishing Platform to all of their IP addresses, set

server.machinename=localhost, server.bindtoip=false, and

server.addtionalnames=[non-default-ip1],[non-default-ip2].

Set the server.additionalnames value to specify the global IP address where6.

the firewall is exposed.

Enter the webServer.port value you configured for Tomcat (8080, for7.

example).

To allow users to log on to Quark Publishing Platform Server even when the8.

directory server is not running, set authentication.external.cacheTicket
= true.
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To set the password case sensitivity, set the9.

server.password.case.sensitive value to false if case sensitivity is not

considered for comparing passwords. This option is not valid if using LDAP for

external authentication.

To configure a session timeout, set the session.maxIdle value to specify the10.

session timeout in seconds. and set the session.eviction.thread.delay
value to specify the frequency of the session eviction thread in seconds.

The Repository status updater is the background thread that runs at a specified11.

frequency to test whether the underlying repository is active or not and to

update the status of the same in server database. To configure the repository

status updater’s sleep interval, set the

repository.status.updator.sleepInterval value to specify the interval

in seconds after which the repository status update thread should run.

If the Realm verif. For Admin. Requests is set in QuarkXPress Server, the12.

username and password for QuarkXPress Server need to be set in this file. Set

the following properties to configure the QuarkXPress Server:

Set the qxps.username value to specify the QuarkXPress Server username.•

Set the qxps.password value to specify the QuarkXPress Server password.•

Set the qxps.locale value to specify the location of QuarkXPress Server.•

Editing “PublishingPool.properties”

To edit “PublishingPool.properties”:

Open the “PublishingPool.properties” file in the Server Installation conf folder.1.

Set the publishingThread.pool.maxActive value to specify the maximum2.

number of background publishing threads that can run simultaneously.

Set the publishingThread.pool.maxIdle value to specify the maximum3.

number of idle threads in the pool.

Set the publishingThread.pool.minIdle value to specify the minimum4.

number of idle threads in the pool.

Set the publishingThread.pool.maxWait value to specify the time in5.

milliseconds that the publishing request should wait while borrowing a thread

from the pool.

Set the publishingThread.pool.minEvictableIdleTimeMillis value to6.

specify the time in milliseconds for a thread to be in the pool before it can be

evicted.

Set the publishingThread.pool.timeBetweenEvictionRunsMillis value7.

to specify the time in milliseconds after which the evictor thread should run to

remove idle threads.

Configuring Quark Publishing Platform Renderer for Quark Publishing
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Platform usage

To configure Quark Publishing Platform Renderer for Quark Publishing Platform

usage:

Open the QXPSM Admin Client by navigating to the following URL in a Web1.

browser: http://[QPP server name]:[port]/qxpsmadmin.

In the Manage Servers pane, click Add Servers and add the Quark Publishing2.

Platform instance of Quark Publishing Platform Renderer. For more

information, see A Guide to Quark Publishing Platform Renderer.

Editing “Qla.properties”

To edit “Qla.properties”:

Open the “Qla.properties” file in the [QPP Server]/conf folder.1.

Enter the IP address or hostname of the QLA Server in the2.

QlaServer.machinename= field.

Enter the port number of the QLA Server in the QlaServer.port= field.3.

If you have a backup QLA server, enter the IP address (or hostname) and port4.

number in the Backup.QlaServer.machinename= and

Backup.QlaServer.port= fields.

Enter the Quark Publishing Platform serial number in the Qla.SerialNumber=5.

field.

The QLA Server Console and QLA Client applications display your Quark
Publishing Platform serial number.

Save and close “Qla.properties.”6.

Extended configuration files

Configuration files are split into base and ext for ease of deployment.

User specific custom beans, processes and publishingchannels should be defined

in .ext files in the Server Installation ext folder, to separate custom extensions and

maintain them after a software upgrade.

ChannelConfig-ext.xml•

content-mimetype-mappings-ext.xml•

custom-xml-types-ext.xml•

IndexingChannels-ext.xml•

PluginsContext-ext.xml•

ProcessConfig-ext.xml•

PublishingConfig-ext.xml•
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Configuring user display name in the User Activity panel in admin web client

You can configure Quark Publishing Platform to display the user name in the User

Activity panel in one of three ways:

[username]•

[username] ([first name] [last name])•

[username] ([last name], [first name])•

To change this setting, open the “WebAdminConfig.properties” file in the [QPP
Server]/webapps/admin/WEB-INF/classes folder. Set the value of the

userNameFormatting property to one of the following:

0 to display as [username].•

1 to display as [username] ([first name] [last name]).•

2 to display as [username] ([last name], [first name]).•

Configuring Platform Server to be used for publishing with Quark XML
Author - SharePoint Adapter

To configure Quark Publishing Platform Server to be used for publishing with Quark

XML Author - SharePoint Adapter:

Open the “sharepoint.properties” file in the [QPP Server]/publishing1.

folder.

Set the sharepoint.username value to be the login name of a user with access2.

to SharePoint sites.

Set the sharepoint.userpassword value to be the login password of the user3.

specified above.

Set the sharepoint.userdomain value to be the domain of the user specified4.

above.

Set the sharepoint.sitecollection value to be the URL of a SharePoint Site5.

Collection which contains documents required during publishing.

Restart the Server.6.

Configuring Platform Server to be used for publishing with Quark XML
Author - FileNet Adapter

To configure Quark Publishing Platform Server to be used for publishing with Quark

XML Author - FileNet Adapter:

Open the “contentengine.properties” file in the [QPP Server]/publishing1.

folder.

Set the filenet.stanza value to be the stanza for filenet content engine2.

connection. You need to edit the parameter only when the filenet server is

configured to use a stanza other than FileNet.

Set the filenet.username value to be the FileNet username.3.
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Set the filenet.userpassword value to be the value to be the FileNet4.

password of the user specified above.

Set the filenet.connectionuri value to be the Connection URI of the5.

FileNet Content Engine WebService.

Restart the Server.6.

JVM memory allocation on Windows

On Windows, you can specify JVM memory allocation in different locations,

depending on how you start Quark Publishing Platform Server. On 64-bit operating

systems, you can allocate more memory for the Quark Publishing Platform Java

process. In either case, you should not allocate more than 50 percent of available

memory.

Using Quark Publishing Platform Server Console or Quark Publishing
Platform Server Windows service

Stop Quark Publishing Platform Server.1.

If you start Quark Publishing Platform Server with Quark Publishing Platform2.

Server Console or Quark Publishing Platform Server Windows service, open the

“wrapper.conf” file.

Search for the wrapper.java.maxmemory property.3.

Adjust the value. On a 64-bit operating system, you can make the value larger.4.

Save your changes and restart Quark Publishing Platform Server.5.

Using “Serverstartup.bat”

Stop Quark Publishing Platform Server.1.

If you start Quark Publishing Platform Server with the “ServerStartup.bat” file in2.

the Quark Publishing Platform Server installation folder, open

“ServerStartup.bat”.

Search for java -server -Xmx2048m -XX:MaxPermSize=256m -3.

classpath.2048m. represents 2048MB of RAM allocated to Quark Publishing

Platform Server.

On a 64-bit operating system, you can make the value larger.4.

Save your changes and restart Quark Publishing Platform Server.5.

Configuring Windows authentication

Windows users can log on to Quark Publishing Platform transparently with their

Windows user credentials, without ever having to see a login dialog box. Quark

Publishing Platform supports all Windows authentication schemes, including

NTLM-v1/NTLM-v2 and Negotiate/Kerberos. The Platform also supports mixed-

mode, so Windows authentication and Platform authentication can coexist.
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You configure Windows authentication with a pluggable HTTP servlet filter. You can

easily enable and disable authentication at deployment time by adding a security

filter to each Web application‘s “web.xml” file.

Each web application of Quark Publishing Platform can be configured to use

different Windows authentication schemes as indicated below.

Steps to enable SSO in Platform Clients

For the Admin web app:

Go to C:\Program Files\Quark\Quark Publishing1.
Platform\Server\webapps\admin\WEB-INF

Open the “Web.xml” file and uncomment the following snippet:2.

</p><p>
<filter></p><p>

<filter-name>SecurityFilter</filter-name></p><p> 
<filter-

class>com.quark.web.security.servlet.ApplicationSecurityFilter
</filter-class></p><p>

<init-param></p><p>
<param-name>provider</param-name></p><p>
<param-

value>com.quark.web.security.wafflle.WaffleAuthenticationProvi
der</param-value></p><p>

</init-param></p><p>
<init-param></p><p>

Web application NTLM only Negotiate/Kerberos only NTLM and Kerberos

Workspace NTLM Negotiate NTLM Negotiate

Admin NTLM Negotiate NTLM Negotiate

Web services NTLM Kerberos NTLM Negotiate

QXPSM N/A N/A N/A

Messaging N/A N/A N/A

REST N/A N/A N/A
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<param-name>provider/protocols</param-name></p><p>
<param-value>NTLM</param-value></p><p> 

</init-param></p><p>
</filter></p><p>
<filter-mapping></p><p>

<filter-name>SecurityFilter</filter-name></p><p>
<url-pattern>/*</url-pattern></p><p>

</filter-mapping>
</p><p>
Save the file.3.

For Workspace and Desktop clients go to the respective web app, open the web.xml

file and uncomment the same snippet.

For desktop clients: C:\Program Files\Quark\Quark Publishing•
Platform\Server\webapps\webservices\WEB-INF

For workspace: C:\Program Files\Quark\Quark Publishing•
Platform\Server\webapps\workspace\WEB-INF

The Platform server should be running as a service with an account as Local System.

Steps to configure Web Client for mixed mode authentication

Go to C:\Program Files\Quark\Quark Publishing1.

Platform\Server\webapps\workspace. Make a copy of PreLogin.jsp and

name it local.jsp.

Go to C:\Program Files\Quark\Quark Publishing2.
Platform\Server\webapps\workspace\WEB-INF

Open the “Web.xml” file and uncomment the following snippet, adding the3.

bold lines:

< filter >
< filter-name > SecurityFilter </ filter-name >
< filter-class >

com.quark.web.security.servlet.ApplicationSecurityFilter </
filter-class >

< init-param >
< param-name > provider </ param-name >
< param-value >

com.quark.web.security.wafflle.WaffleAuthenticationProvider </
param-value >

</ init-param >
< init-param >

< param-name > provider/protocols </ param-name >
< param-value > NTLM </ param-value >

</ init-param >

<init-param>      <param-name>exclude-url-patterns</param-
name>      <param-value>/local.jsp,/Login.jsp</param-value>
</init-param>
</ filter >
< filter-mapping >

< filter-name > SecurityFilter </ filter-name >  
< url-pattern > /* </ url-pattern >

</ filter-mapping >

Save the file.4.
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Restart the server and access the corresponding web applications with the5.

following URLs:

For access through native Platform user authentication use the URL :•
http://localhost:61400/workspace/local.jsp

For access through Windows authentication use the URL:•
http://localhost:61400/workspace/

The steps above can be repeated for Web Admin or other web apps as well.

Editing “log4j.xml”

Adding user information to logged events

You can configure the log4j.xml file to populate each logged event with the user ID

and user name:

Open the “log4j.xml” file in the {QPP Server}/conf folder.1.

Set the conversionPattern parameter:2.

<appender name=”QpsServerAllFileAppender”
class=”org.apache.log4j.RollingFileAppender”>

<param name=”file” value=”log/QppServer.log”/>
<param name=”maxFileSize” value=”10MB”/>
<param name=”maxBackupIndex” value=”10”/> 
<layout class=”org.apache.log4j.EnhancedPatternLayout”>

<param name=”conversionPattern” value=”%d %p [%c][%t] 

[User(Id:%properties{qpp.user.id},Name:%properties{qpp.user.na
me})] - % m%n”/>

</layout>
</appender>

Configuring logging levels

You can edit the “log4j.xml” file to adjust logging levels, and you can use JConsole

to change logging levels after starting Quark Publishing Platform Server. You can

also set different logging levels for exceptions.

Changing logging levels in “log4j.xml”

You can change the logging levels for Quark Publishing Platform Web Client and

Quark Publishing Platform Server. Options include ERROR, INFO, WARN, DEBUG,

SQLTRACE, and TRACE.

ERROR = includes messages that indicate disrupted and failed requests.•

INFO = includes messages that indicate the state of services.•

WARN = includes non-critical service error messages.•

DEBUG = includes messages that indicate server resource usage.•

SQL_TRACE = includes messages according to activity related to SQL requests.•

TRACE = includes messages according to activity related to requests.•
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Refer to Java documentation for more information about logging levels.

To change logging levels:

Open the “log4j.xml” file in the {QPP Server}/conf folder.1.

To define the logging level for Quark Publishing Platform Web Client activity,2.

scroll to <logger name=com.quark.qpp.web.webeditor. The structure is as

follows:

<logger name=”com.quark.qpp.web.webeditor” additivity=”false”>
<level value=”INFO” /> <appender-ref ref=”WebHubAsyncAppender”
/> </logger>
To define the logging level for Quark Publishing Platform Server activity, scroll3.

to <logger name=com.quark.qpp. The structure is as follows:

<logger name=”com.quark.qpp”> <level value=”INFO” /> </logger>
To define the logging level for other activity, scroll to the “<root>.” The4.

structure is as follows:

<root> <priority value=”ERROR” /> <appender-ref
ref=”QppServerAsyncAppender” /> </root>
Save and close “log4j.xml.”5.

Changing logging levels after starting Quark Publishing Platform
Server

With Quark Publishing Platform Server running, display the Platform Server1.

Console.

Click JConsole to display a window for monitoring different aspects of Quark2.

Publishing Platform Server performance.

Click the MBeans tab. Separate Quark Publishing Platform Server functions3.

display in tree format on the left side of the MBeans tab.

Open Platform Server > Logging in the tree.4.

Click the Operations tab.5.

Use JConsole to adjust logging priority levels

To edit the log level of Quark Publishing Platform Server or the Quark6.

Publishing Platform Web Client, set the logging level in the text box and click

the corresponding button.
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The changes you make in JConsole take effect immediately, but when you restart
Quark Publishing Platform Server, the settings in “log4j.xml” are applied.

Changing logging for exceptions

You can set logging for known and unknown exceptions by editing two values in

the “ServerApp.properties” file.

Open the “conf” folder in your Quark Publishing Platform Server folder.1.

Open “ServerApp.properties” in a text editing application.2.

If you don’t want to log Quark Publishing Platform exceptions in the Quark3.

Publishing Platform Server log, set server.logqppserviceexception to

false.

If you want to avoid logging unknown exceptions, set server.logthrowable4.

to false.

Save and close “ServerApp.properties.”5.

Logging Messages

Use the following appenders in log4j.xml to log various events to a separate log file

named MessagePublisher.log:

MessagePublisherAppender•

MessagePublisherAsyncAppender•

MessagePublisherFileAppender•

Monitoring database health

User the following appenders in log4j.xml to log information helpful in monitoring

database health in the “DatabaseMonitoring.log” file:

DatabaseMonitoringAppender•

DatabaseMonitoringAsyncAppender•

DatabaseMonitoringFileAppender•

Modifying search notification evaluation settings

Quark Publishing Platform Server notifies all open Search Results palettes if the

assets displayed in the palettes have been modified. You can edit several parameters

to influence the strategy and resources used to evaluate conditions and deliver these

query notifications. The optimal value for most parameters depends on the database

and hardware you choose for your Quark Publishing Platform Server.

Only an experienced administrator should change the settings described below.
Please consult Quark Enterprise Support for assistance.

Open the “conf” folder in your Quark Publishing Platform Server folder.1.

Open “Query.properties” in a text editing application.2.
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Quark Publishing Platform Server uses two pools of threads to evaluate query3.

notifications — the “Generic Notification Evaluator Thread Pool Configuration”

and the “Simple Notification Evaluator Thread Pool Configuration.” The

“generic” thread pool evaluates query notifications using a database. The

“simple” thread pool uses a simpler strategy to evaluate query notification

without involving a database. Adjust the following properties in the “Generic

Notification Evaluator Thread Pool Configuration” area:

To specify the maximum number of concurrent threads that operate in the•

background to evaluate notifications that require database access, adjust the

query.notification.generic.pool.maxActive value. Increase this

value to improve performance when using hardware with several processors

and extensive system memory.

To specify the maximum number of idle threads in the pool, adjust the•

query.notification.generic.pool.maxIdle property.

To specify the minimum number of idle threads in the pool, adjust the•

query.notification.generic.pool.minIdle property.

To specify the minimum time that a thread can be idle before it can be•

removed from the pool, set the time in milliseconds for the

query.notification.generic.pool.minEvictableIdleTimeMillis
property.

To specify the number of milliseconds after which a background evictor•

thread should run to clean up idle threads, adjust the
query.notification.generic.pool.timeBetweenEvictionRunsMill
is property.

Query notifications for certain asset changes can be evaluated efficiently using a4.

simpler strategy that does not require database access. Adjust the following

properties in the “Simple Notification Evaluator Thread Pool Configuration”

area:

To specify the maximum number of concurrent threads that operate in the•

background, adjust the query.notification.simple.pool.maxActive
value. Increase this value to improve performance when using hardware

with several processors and extensive system memory.

To specify the maximum number of idle threads in the pool, adjust the•

query.notification.simple.pool.maxIdle property.

To specify the minimum number of idle threads in the pool, adjust the•

query.notification.simple.pool.minIdle property.

To specify the minimum time that a thread can be idle before it can be•

removed from the pool, set the time in milliseconds for the

query.notification.simple.pool.minEvictableIdleTimeMillis
property.

To specify the number of milliseconds after which a background evictor•

thread should run to cleanup idle threads, adjust the
query.notification.simple.pool.timeBetweenEvictionRunsMilli
s property.
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To configure JMS topology for query notification, adjust the5.

query.notification.topicPerSession property. To emulate the behavior

of versions of Quark Publishing Platform prior to 8.1, set this value to false.

The default display is used when executing a search for which a user specific6.

display does not exist ( for example, when browsing a collection for the first

time). To specify the default query display settings, adjust the following

properties in the “Default Query display Settings” area:

To specify the default query display settings for asset queries, adjust the

following properties:

To specify the columns to be displayed in asset queries, adjust the•

query.display.default.assets.columns value to contain a list of the

columns you want displayed.

To specify the display mode for asset queries (PLAIN, THUMBNAIL or•

SNIPPET), adjust the query.display.default.assets.displaymode
property.

To specify the explore mode for asset queries (PLAIN, PROJECT, PROJECT•

AND PAGE, RELATION, RELATED ASSETS, COLLECTIONS), adjust the

query.display.default.assets.exploremode property.

To specify the desired grouping of the assets, adjust the•

query.display.default.assets.grouping property.

To specify the desired sorting of the assets, adjust the•

query.display.default.assets.sorting property.

To specify the default query display settings for collection queries, adjust the

following properties:

To specify the columns to be displayed in collection queries, adjust the•

query.display.default.collections.columns property to contain a

list of the columns you want displayed.

To specify the display mode for collection queries (PLAIN or THUMBNAIL),•

adjust the query.display.default.collections.displaymode
property.

To specify the desired sorting of the assets in collection queries, adjust the•

query.display.default.collections.sorting property.

Do not edit the values of other properties in the “Query.properties”7.

configuration file.

Save and close “Query.properties.”8.

Restart Quark Publishing Platform Server for these settings to take effect.9.

Database properties

You can manually specify the database connection URL, database user name,

database user password, and database connection pool size.

To change database properties:
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In the “Database.properties” file located in the [QPP Server]/conf folder.1.

Scroll to the Database related configuration section.2.

To specify the driver class name, replace the qpp.jdbc.driverClassName3.

value. For example, for an HSQL database, you would use

qpp.jdbc.driverClassName=org.hsqldb.jdbcDriver.

To specify the database connection URL, replace the path after qpp.jdbc.url.4.

To specify the database user name, replace the qpp.jdbc.userName value.5.

To specify the database user password, replace the qpp.jdbc.password value.6.

To specify the database connection pool size, change the qpp.jdbc.maxActive7.

value.

To specify the maximum and minimum numbers of connections that can be8.

idle, change the qpp.jdbc.maxIdle and qpp.jdbc.minIdle values.

To specify the minimum time in milliseconds that a connection must be in the9.

pool before it can be evicted, change the

qpp.jdbc.minEvictableIdleTimeMillis value.

To specify the minimum time in milliseconds after which the evictor thread10.

should run to remove an idle connection, change the

qpp.jdbc.timeBetweenEvictionRunsMillis value.

To adjust the pooling of prepared statements, change the11.

qpp.jdbc.poolPreparedStatements value.

To specify the maximum number of connections to be made in the no-12.

autocommit pool , change the qpp.jdbc.maxActive_noAutoCommit value.

Save and close “Database.properties.”13.

If there is a firewall configured between the Platform Server and the Database server
that can terminate TCP sessions when they are idle for a long time, the following

configuration changes should be done in the “Database.properties” file .

Set the qpp.jdbc.minIdle value to 0•

Set the qpp.jdbc.minEvictableIdleTimeMillis value to 60000•

Set the qpp.jdbc.timeBetweenEvictionRunsMillis value to 60000•

Platform Server needs to be restarted for these settings to take effect.

Transformation properties

You can use transformation properties to modify the output of various predefined

transformations. Changes to the “Transformation.properties” file alter the external

commands that are invoked for transforming assets. Commands in this file can

contain predefined macros such as <temp>, <source>, <extension> and

<output>.

To change transformation properties:

Open the “Transformation.properties” file located in the [QPP Server]/conf1.

folder.
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To specify a pattern that does not occur as a value (or part of a value) for any2.

other property, specify a value for transformer.spaceEncodingPattern.

This pattern is used for escaping spaces in commands and other property values.

To specify which file types ImageMagick is allowed to handle, enter a comma-3.

separated, case-insensitive list of file extensions in

imTransformer.extensions.

To specify the temporary file location to be used by ImageMagickTransformer,4.

specify a path for imTransformer.tempDir.

To specify the ImageMagick command to be executed for generating output5.

with ImageMagickTransformer, enter a value for

imTransformer.jpg.imCommand.

To specify which file types the JawsTransformer is allowed to handle, enter a6.

comma-separated, case-insensitive list of file extensions in

jawsTransformer.extensions.

To specify the temporary file location to be used by JawsTransformer, specify a7.

path for jawsTransformer.tempDir.

To specify the Jaws command to be executed for generating output with8.

JawsTransformer, enter a value for jawsTransformer.jpg.command.

Save and close “Transformation.properties.”9.

Session timeout

You can specify how long individual sessions can remain idle before they are timed-

out, as well as the frequency of testing for idle sessions.

To specify timeout parameters:

Open the “ServerApp.properties” file located in the [QPP Server]/conf1.

folder.

Scroll to the session.maxIdle= entry.2.

Enter the number of seconds a session can be idle before timing out.3.

To specify the frequency for Quark Publishing Platform Server to perform a4.

background check for idle sessions, enter a number (measured in seconds) in

the session.eviction.thread.delay property.

Save and close “ServerApp.properties.”5.

Web Client timeout settings can be changed by adjusting the ajaxTimeout entry in
the “Workspace-Config.xml” file (this entry is in milliseconds). This file is located at
{install_folder}/webapps/workspace/WEB-INF/classes

Repository status updater

You can specify a background thread that runs frequently to confirm the Quark

Publishing Platform File Server status.

To specify the repository status update interval:
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Open the “conf” folder in your Quark Publishing Platform Server folder.1.

Open “ServerApp.properties” in a text editing application.2.

Scroll to the repository.status.updator.sleepInterval= entry.3.

Enter a value to specify the number of seconds after which the repository status4.

updater thread will run.

Save and close “ServerApp.properties.”5.

Moving Quark Publishing Platform Renderer

If you need to move your Quark Publishing Platform Renderer to a different

computer, you don’t have to re-install Quark Publishing Platform Server. Instead,

you can edit the “ManagerConfig.xml” file, as follows:

Open the “ManagerConfig.xml” file located in the [QPP Server]/conf folder.1.

Scroll to the <connectioninfo> section at the bottom of2.

“ManagerConfig.xml.”

Change the name entry value to the IP address or hostname of the new Quark3.

Publishing Platform Renderer.

Change the port entry value to the port number you specified for the new4.

Quark Publishing Platform Renderer.

Save the “ManagerConfig.xml” file and launch Quark Publishing Platform5.

Server.

To verify the change, search through the “QppServer.log” file for the line6.

Successfully registered with QXPS.

Alternatively, you can open the Quark Publishing Platform Renderer Manager client
with the URL http://[server]:[port]/qxpsmadmin and make these changes

there.

Unless you check Realm verif. For Admin. Requests and enter a user name and
password in the HTTP tab of the QuarkXPress Server Configuration dialog box,

you can leave the <user> and <password> entries blank. This also applies to the

username and password fields in the “ServerApp.properties” file (qxps.username
and qxps.password).

Integrating Quark Publishing Platform with LDAP Directory Servers:

Many system administrators use directory services to manage users on an enterprise

network, such as Lightweight Directory Application Protocol (LDAP). Quark

Publishing Platform administrators are not required to use LDAP, but if they rely on

LDAP for other systems, then Quark Publishing Platform can be configured so that

Quark Publishing Platform users can log on to Quark Publishing Platform Server

with the same domain username and password they use for other systems on their

enterprise network.

Quark Publishing Platform Server works with LDAP v3 supported by this
implementation.
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Managing LDAP profiles

Before you can import LDAP users/groups into Quark Publishing Platform, you must

create an LDAP profile to bind to your LDAP Server. An LDAP profile lets you supply

the LDAP-Server credentials along with other details that are necessary to allow

import of LDAP users.

To create an LDAP profile:

Click User Profiles.1.

Click Manage LDAP Profiles. The Manage LDAP Profiles dialog box displays.2.

Manage LDAP Profiles dialog box

Under the LDAP Profiles list pane,  click the + button to create a new LDAP3.

profile.

Enter a name for the LDAP profile.4.

Choose the LDAP server’s authentication method from the Authentication5.

Type drop-down menu. Valid values include Kerberos, Digest-MD5, and

Simple.

Most of the LDAP servers running on Windows like Microsoft Active Directory
LDAP Server use Kerberos authentication, but LDAP servers running on

Linux/Solaris like Open Ldap Server or IBM Directory Server use Simple

Authentication.

Enter the realm name in the Realm field.6.

Each profile must have a unique realm name.

Enter the user name and password of a user who has read access to the7.

Directory Server (that is, the designated name in the Directory Server). This user

authentication will be used to retrieve the list of users from the Directory Server.

To add an LDAP server to the profile, click the + button under the Servers list.8.

Enter the Server Name, Port and Scheme for the new server.9.
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Click Apply.10.

The Identification Criteria tab displays requesting that you fill in the value for

Base DN (A base dn is the point from where a server will search for users).

For more information, see “Identification criteria“.

Click Done.11.

Ldap Attribute Mapping:

Before you can import LDAP users into Quark Publishing Platform, you must map

the LDAP attributes to Quark Publishing Platform user’s attributes.

To map LDAP user attributes:

Click User Profiles.1.

Click Manage LDAP Profiles. The Manage LDAP Profiles dialog box displays.2.

Select the LDAP Attribute Mapping tab.

LDAP Attribute Mapping tab of the Manage LDAP Profiles dialog box

LDAP attributes need to be mapped to the corresponding attributes of Users and
Groups in Quark Publishing Platform. For each field in the tab, the corresponding

LDAP attribute name should be specified.

The following 3 attributes are  mandatory and should be mapped with your

existing LDAP Server attributes as explained below:

User Name : This is the name of the attribute that contains the user name that1.

you see in Quark Publishing Platform Server after import and is used to log on

to Platform.

For example, in Microsoft windows active directory, the attribute name is
samaccountname. In Other LDAP servers like Open  LDAP Server , IBM

Directory Server  this value is uid.
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Authentication Name: This is the name of the attribute that contains the user2.

name used for authentication in your LDAP server.

Distinguished Name: This is  the name of the attribute that contains the3.

distinguished value or unique identifier of the user in the LDAP server.  

For example, in Microsoft Windows Active Directory the name of the attribute
is distinguishedname and it holds the value of user as : cn=Joginder

Singh,ou=users,dc=example,dc=com. In some other LDAP servers like IBM

Directory Server and Open Ldap server on linux/solaris , the attribute used is

:uid or uid.

To map LDAP Group Attributes:

Group Name: This is the name of the attribute that contains the name of the1.

group in your LDAP server.

Distinguished Name : This is the name of the attribute that contains the2.

complete list of distinguished names of the groups in your LDAP server. 

For example, in Microsoft Windows Active Directory the name of the attribute
is distinguishedname and it hold the value of group as :

CN=Managers,ou=groups,dc=example,dc=com. In some other LDAP servers

like IBM Directory Server and Open Ldap server on linux/solaris , the attribute

used is  CN

Email : This is the name of the attribute that contains the value of email in3.

your LDAP server.

Identification criteria:

Use the identification criteria tab to define the attributes and filters that enable you

to define the search criteria and provide more efficient and effective searches. The

identification criteria allows you to describe the base dn for any active directory in

your organization. A base dn is the point from where a server will search for users.

To describe the LDAP identification criteria:

Click User Profiles.1.

Click Manage LDAP Profiles. The Manage LDAP Profiles dialog box displays.2.

Select the Identification Criteria tab.
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LDAP Attribute Mapping tab of the Manage LDAP Profiles dialog box

Select the LDAP profile whose identification criteria you want to set.3.

Fill out the fields:4.

Enter the base string in the Base DN field. This string represents the search•

base used to search for users in the LDAP Server computer’s hierarchy. The

Base DN field is mandatory.

The User Identification Criteria field allows you to filter for specific users in•

your active directory. The default string represents the search base used to

search for all users in the Active Directory. This field allows you to search for

categories like Person, eliminating machines from showing up in your

searches. The User Identification Criteria field is optional.

The Group Identification Criteria field allows you to search for specific•

groups in your active directory. The default string represents the search base

used to search for all groups in the Active Directory. The Group

Identification Criteria field is optional.

The Group Member Attribute Name field denotes the common attribute of•

the set of users in a group. The Group Member Attribute Name field is

optional.

The Member Identifying Attribute Name field is used to denote•

membership in a group. The Member Identifying Attribute Name field is

optional.

The Filters to get all Users of Group field allows you to specify the criteria•

needed to search for all the users of a particular group. The Filters to get all

Users of Group field is optional.

The Filters to get all Sub-Groups of Group field allows you to specify the•

criteria needed to search for all the sub-groups of a particular group. The

Filters to get all Sub-Groups of Group field is optional.
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The Filters to get all Groups of User field allows you to specify the criteria•

needed to search for all the groups of a particular user. The Filters to get all

Groups of User field is optional.

Click Apply.5.

Importing LDAP users and groups:

To import users and groups from your LDAP service:

Click User Profiles.1.

Click Import Users and Groups From LDAP. The Import Users and Groups2.

from LDAP dialog box displays.

Use the Import Users and Groups From LDAP dialog box to add users or groups to your

Quark Publishing Platform list. 

The search controls at the top of the dialog box let you specify which users or3.

groups you want to be able to import. To create a search:

Choose the name of the appropriate LDAP profile from the Profile Name•

drop-down menu.

Choose to search Users or Groups.•

Enter the search criteria in the Search Criteria field. For example, to import•

all LDAP users that meet the criteria samaccountname=*, enter
samaccountname=*

Enter the base string in the Base String field. In this string, ou is an•

abbreviation for “organizational unit” and dc is short for “domain

component.” This string represents the search base used to search for users

in the Active Directory server computer’s hierarchy.
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Click Save to save the search and provide a name for the search in the•

dialog box that displays.

Choose the search to execute. The matching users or groups are listed on the4.

left.

Select one or more names from the LDAP Users/Groups list on the left and5.

click the right arrow to add the selected users or groups to the Quark

Publishing Platform list of users or groups on the right.

The Assign Role dialog box displays.

Use the Assign Role dialog box to assign a role to a Quark Publishing Platform user or

group.

Choose a role from the Role drop-down menu in the Assign Role dialog box6.

and then click OK.

You can change the search criteria, execute more searches, and continue to add
users/groups until you click OK in the Import Users from LDAP dialog box.

Click OK. The users or groups in the list on the right are imported.7.

If you duplicate a Quark Publishing Platform user or group that you imported from
your LDAP service, the duplicated user or group is not connected to your LDAP

service (that is, it’s like creating a new user or group).

You cannot have two Quark Publishing Platform users or groups with the same
name. If you attempt to add a user or group name that is the same as an existing

name, you will not be allowed to add the duplicate name.

When you import a group, all users in that group will be imported. If the group you
imported contains sub-groups, the sub-group and all users within that sub-group

will also be imported. When you assign a Role to a group, all users in that group will

be assigned that role. If you import a group from LDAP, you cannot add users to

that group using Quark Publishing Platform, you must add users to these groups

using active directory.

A Quark Publishing Platform administrator must have the “Manage LDAP Users“
privilege for the Import Users from LDAP functionality to be available.
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If you combine users into groups, you can route an asset to a group, and any user in
that group can check out the asset and work on it. To create and delete groups, click

Groups.

Connecting LDAP user passwords with Quark Publishing Platform Server

If you configure Quark Publishing Platform according to the instructions below and

the connection between Quark Publishing Platform Server and Directory Server

breaks, users can still log on to Quark Publishing Platform Server with their

Directory Server credentials.

When a user logs on to Quark Publishing Platform Server successfully for the first

time, encrypted user credentials are stored in Quark Publishing Platform. These

credentials can then be used for subsequent log on operations when there is no

connection between Quark Publishing Platform Server and Directory Server.

To specify that the LDAP user password can be retrieved, encrypted, and stored in

the Quark Publishing Platform Server database:

Open the “ServerApp.properties” file located in the [QPP Server]/conf1.

folder.

To allow users to log on to Quark Publishing Platform Server when the2.

connection between Quark Publishing Platform Server and Directory Server is

broken, change the value for authentication.external.cacheTicket= to

true. The default setting for authentication.external.cacheTicket= is

false (that is, disabled).

To indicate that it is required to evaluate the3.

“CollectionInfo#isAccessibleChildrenAvailable()” flag at runtime for every

collection in context, the value of

collections.evaluateAccessibleChildrenFlag= should be true
(default).

Once an element is fetched from the LDAP server, it will be cached in the4.

Platform Server and provided from the cache for a specified number of seconds,

and fetched again after that time. To specify time to live (in seconds) for LDAP

cache elements, set the value for ldap.cache.timetolive=.

To specify the LDAP synchronization time delay (in seconds), set the value for5.

ldap.synchronization.thread.delay= to true. If LDAP synchronization is

not required, set the value to -1.

Save and close “ServerApp.properties.”6.

Restricting Workspace Browser palettes

To restrict the number of Workspace Browser windows a user can have open at one

time:

Open the “Query.properties” file located in the [QPP Server]/conf folder.1.

Specify a value for the query.maxWatchedQueryCountPerSession parameter.2.

Save and close “Query.properties”.3.
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Changing query results settings

To limit the number of results that will be returned for an Assignments based•

search, specify a positive non-zero value for the

query.maxAssignmentFetchCount parameter.

To limit the number of results that will be returned for a User based search,•

specify a positive non-zero value for the query.maxRowFetchCount parameter.

Setting up custom content type detection

By default, Quark Publishing Platform is configured to recognize Quark formats,

common picture formats, common content formats (Microsoft Office, plain text,

RTF, PDF, HTML), XML, XHTML, DITA documents, and BusDoc documents.

However, you can configure Quark Publishing to automatically attempt additional,

custom content types. To do so:

To recognize a particular content type by examining a file’s MIME type, make1.

sure that MIME type is listed in the “tika-mimetypes.xml” file. If the MIME type

is not included in this file, you can add it to the “custom-mimetypes” file. You

can identify file types by file extension, by magic bytes, or (for XML files) by the

root element. For example:

<mime-type type=”application/dita+xml; format=busdoc”>
<sub-class-of type=”application/dita+xml;format=topic”/>
<_comment>Business Documents</_comment>

</mime-type>
You can assign different MIME types to structurally similar but semantically

different XML files. You can differentiate XML file types based on processing

instructions applied inside that XML. Add a MIME type entry to the “custom-

xml-types-ext.xml” file present in “ext” folder of the Platform server, to do so.

For example:

<mime-type type=”application/dita+xml; format=busdoc”  sub-
class-of=”application/dita+xml; format=topic”>

<pi name=”Xpress”>productLine=”busdoc”</pi>
</mime-type>
For more information, see http://tika.apache.org.

Configure a Quark Publishing Platform content type based on the identified2.

MIME type. To do so, add a mapping entry to the “content-mimetype-

mappings-ext.xml” file present in “ext” folder of the Platform server. Assets with

the specified custom MIME type will be checked in with the specified custom

content type. For example:

<content-type name=”Business Document”>
<mime-type>application/dita+xml; format=busdoc</mime-type>

</content-type>
Add a corresponding mapping entry to the “Indexing Channels-ext.xml” file3.

present in “ext” folder of the Platform server. For example:

<mapping contenttype=”Ratings Document”
channel=”ratingsPreviewChannel”>

<parameter name=”channelParam1”>param value</parameter>
<parameter name=”channelParam2”>param value</parameter>

</mapping>

http://tika.apache.org
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Specifying a default PDF output style

Quark Publishing Platform Web Client users can retrieve copies of QuarkXPress

projects or QuarkCopyDesk articles as PDFs. The settings for these PDFs are defined

exclusively in the default PDF output style for QuarkXPress Server. To specify the

default PDF output style, update the default Job Jackets file as described in “Job

Jackets dialog box” in A Guide to QuarkXPress Server. The default PDF style can also

be mentioned in the Publishing Channel used to take the PDF. The default channel

for taking PDF from QuarkXPress projects is “qxpPdf”.

Controlling delivery channel display settings in Web Client

Delivery channels are not visible by default. To make them available, set the

property displaydeliverychannels to true in the file

QPP_HOME\webapps\workspace\WEB-INF\classes\Workspace-Config.xml:

<property name=”enableDeliveryChannels” value=”true” />

Changing case-sensitivity for Quark Publishing Platform passwords

To specify case-sensitivity for Quark Publishing Platform user passwords:

Open the “ServerApp.properties” file located in the [QPP Server]/conf1.

folder.

If you want to specify case-sensitivity for user passwords, set2.

server.password.case.sensitive to true. Otherwise, enter false.

Save and close “ServerApp.properties.”3.

The default setting for server.password.case.sensitive is true. Quark
Publishing Platform administrators should inform users if case-sensitive passwords

are required.

Managing filters and index service settings

Quark Publishing Platform Server uses four filters for generating previews, and you

can change the values in the “.properties” files for each filter. These files include:

The “AsposeFilterServiceConfig” file provides previews and thumbnails of Word,•

RTF,EXCEL,POWER POINT and plain text files.

The “QxpsFilterServiceConfig.properties” file provides previews and thumbnails•

of QuarkXPress projects and QuarkCopyDesk articles.

The “IMFilterServiceConfig.properties” file provides previews and thumbnails of•

most image files.

The “JawsFilterServiceConfig.properties” file provides previews and thumbnails•

of certain image files — PDF files, EPS files, and Adobe® Illustrator® files.

The “XADocFilterServiceConfig.properties” file provides previews and•

thumbnails of XML files.

The following commands are common to all four filters:
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<FILTER_NAME>filter.generateAttributes: Set this to true to generate•
filter-specific attributes.

<FILTER_NAME>filter.generatePreview: Set this to true to generate•
previews.

<FILTER_NAME>filter.generateThumbnail: Set this to true to generate•
thumbnails.

<FILTER_NAME>filter.generateText: Set this to true to extract text and•
enable full-text search.

<FILTER_NAME>filter.previewWidth: Set this to specify the width of•
previews (measured in pixels).

<FILTER_NAME>filter.previewHeight: Set this to specify the height of•
previews (measured in pixels).

<FILTER_NAME>filter.thumbnailHeight: Set this to specify the height of•
thumbnails (measured in pixels).

<FILTER_NAME>filter.thumbnailWidth: Set this to specify the width of•
thumbnails (measured in pixels).

<FILTER_NAME>filter.previewPages: Set this to specify the number of•
preview pages to generate.

<FILTER_NAME>filter.processTimeOut: Set this to specify the number of•
milliseconds after which an incomplete index preview process will terminate.

Index service settings

You can specify parameters for asset indexing. As a separate background process

that runs inside Quark Publishing Platform Server, indexing can consume

significant system resources. By editing the “Indexing.properties” file as described

below, you can manage index processes (called “indexing thread pools”) by

adjusting the number of concurrent thread pools and the time intervals between

thread pools.

To manage timing and threads for asset indexing:

Open the “Indexing.properties” file located in the [QPP Server]/conf folder.1.

To specify the maximum number of concurrent indexing threads that operate2.

in the background, adjust the indexingThread.pool.maxActive= value.

To specify the amount of time (in milliseconds) to wait for an available thread3.

from the pool, adjust the indexingThread.pool.maxWait= value. A value of

-1 indicates waiting indefinitely.

To specify the maximum number of idle threads in the pool, adjust the4.

indexingThread.pool.maxIdle= value.

To specify the minimum number of idle threads in the pool, adjust the5.

indexingThread.pool.minIdle= value.

To specify the number of milliseconds a thread can be in the pool before it is6.

evicted, adjust the indexingThread.pool.minEvictableIdleTimeMillis=
value.
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To specify the number of milliseconds after which the evictor thread should run7.

to evict idle threads, adjust the

indexingThread.pool.timeBetweenEvictionRunsMillis= value. The

evictor thread runs in the background.

When the “evictor” thread is run, it releases all idle threads from the pool
beyond indexingThread.pool.maxIdle value. However, the number of idle

threads specified as indexingThread.pool.minIdle value are maintained in

the pool.

To index assets not previously indexed when Quark Publishing Platform Server8.

starts, enter true for the indexing.indexPendingAssetsOnStartup= value.

Save and close “Indexing.properties.”9.

ASPOSE filter

The ASPOSE filter handles text files, Microsoft Word, Excel and PowerPoint

documents, RTF files and plain text files. Adjust the ASPOSE filter settings:

Open the “AsposeFilterServiceConfig.properties” file located in the [QPP1.

Server]/conf folder.

asposefilter.previewType=png. Supported preview types are png and jpg.2.

asposefilter.generatePreview=true.3.

asposefilter.generateThumbnail=true.4.

asposefilter.generateTableImages=false.5.

asposefilter.generateChartImages=false.6.

asposefilter.thumbnailHeight= entry.7.

asposefilter.thumbnailWidth= entry.8.

asposefilter.previewDpi= entry.9.

asposefilter.reditionPreviewDpi= entry.10.

To specify the time the process should wait before exiting, if indexing is not11.

done, enter a value in the asposefilter.processTimeOut= entry (in

milliseconds).

To specify the maximum number of pages for which preview should be12.

generated, enter a value in the asposefilter.previewPages= entry.

To set the preview page layout margin settings for RTF, XML, HTML, HTM and13.

TXT type files enter values in the following:

asposefilter.text.topMargin= entry.•

asposefilter.text.bottomMargin= entry.•

asposefilter.text.rightMargin= entry.•

asposefilter.text.leftMargin= entry.•

Save and close “AsposeFilterServiceConfig.properties.”14.
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Configure ASPOSE filter for PDF preview

The Platform Server provides two filter implementations for the indexing of PDF

Documents:

Jaws Filter•

Aspose Filter•

By default the JAWS Filter is configured for PDF document indexing. In order to

configure the ASPOSE Filter for PDF document indexing, do the following:

Open the “AsposeFilterServiceConfig.properties” file located in the [QPP1.

Server]/conf folder.

Look for and uncomment the following:2.

<!— <supported-file-type>
<mac-os-type/>
<file-extension>pdf</file-extension>
<mime-type/>
<creator-code/>

</supported-file-type>
<supported-file-type>

<mac-os-type/>
<file-extension/>
<mime-type>application/pdf</mim-type>
<creator-code/>

</supported-file-type>
<supported-file-type>

<mac-os-type/>
<file-extension/>
<mime-type>application/x-pdf</mime-type>
<creator-code/>

</supported-file-type> —>
Open “JawsFilterServiceConfig.properties.” in a text editing application.3.

Look for and comment out the following supported file type:4.

<supported-file-type>
<mac-os-type/>
<file-extension>pdf</file-extension>
<mime-type/>
<creator-code/>

</supported-file-type>

Save and close “AsposeFilterServiceConfig.properties.”5.

Save and close “JawsFilterServiceConfig.properties.”6.

APS filter

Adjust the APS filter settings:

Open the “ApsFilterServiceConfig.properties” file located in the [QPP1.

Server]/conf folder.

apsfilter.generatePreview=true.2.

apsfilter.generateThumbnail=true.3.

apsfilter.generateAttributes=true.4.

apsfilter.generateText=true.5.
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To specify the time the process should wait before exiting, if indexing is not6.

done, enter a value in the apsfilter.processTimeOut= entry (in

milliseconds).

To specify the maximum number of pages for which preview should be7.

generated, enter a value in the apsfilter.previewPages= entry.

Save and close “ApsFilterServiceConfig.properties.”8.

Configure processing of MS Office documents

Adjust the MS Office filter settings:

Open the “OfficeServiceConfig.properties” file in the [QPP Server]/conf1.

folder.

Set the office.defaultImageFormat property to specify the default output2.

format type. Default format is PNG.

Set the office.defaultHorizontalResolution property to specify the3.

default horizontal resolution of previews.

Set the office.defaultVerticalResolution property to specify the default4.

vertical resolution of previews.

Set the office.onePagePerSheet property to true and all content of the5.

sheet will output to only one page.

Set the office.showHiddenWorksheets property to control the visibility of6.

hidden worksheets.

To set the option to remove or hide the hidden columns/rows from the output7.

formats HTML, XHTML, SMARTTABLE and CALS, set the following properties:

office.defaultHiddenColumnDisplayType= entry. The allowed values•
for this option are hide or remove.

office.defaultHiddenRowDisplayType= entry. The allowed values for•
this option are hide or remove.

Set the8.
office.defaultHorizontalResolutionoffice.ppt.document.defaultI
mageFormat property to set the default image format for PowerPoint document

output.

Set the9.
office.defaultHorizontalResolutionoffice.ppt.document.image.de
faultHorizontalScalingFactor property to set the default horizontal

scaling factor for PowerPoint document output. This property is applicable for

JPEG, GIF, PNG and BMP image formats.

Set the10.
office.defaultHorizontalResolutionoffice.ppt.document.image.de
faultVerticalScalingFactor property to set the default vertical scaling

factor for PowerPoint document output. This property is applicable for JPEG,

GIF, PNG and BMP image formats.
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Set the11.
office.defaultHorizontalResolutionoffice.ppt.component.default
ImageFormat property to set the default image format for PowerPoint

document’s slide output.

Set the12.
office.defaultHorizontalResolutionoffice.ppt.component.image.d
efaultHorizontalScalingFactor property to set the default horizontal

scaling factor for PowerPoint document’s slide. This property is applicable for

JPEG, GIF, PNG and BMP image formats.

Set the13.
office.defaultHorizontalResolutionoffice.ppt.component.image.d
efaultVerticalScalingFactor property to set the defaultvertical scaling

factor for PowerPoint document’ slide. This property is applicable for JPEG, GIF,

PNG and BMP image formats..

Set the14.
office.defaultHorizontalResolutionoffice.visio.document.defaul
tImageFormat property to set the default image format for Visio document

output.

Set the15.
office.defaultHorizontalResolutionoffice.visio.document.image.
defaultResolution property to set the default resolution of the image for

Visio document output. This property is applicable for JPEG, GIF and PNG

image formats.

Set the16.
office.defaultHorizontalResolutionoffice.visio.component.defau
ltImageFormat property to set the default image format for Visio document’s

page output.

Set the17.
office.defaultHorizontalResolutionoffice.visio.component.image
.defaultResolution property to set the default resolution of the image for

Visio document’s page. This property is applicable for JPEG, GIF and PNG image

formats.

Throttling mechanism for Parallel request by OfficeService and
ChartingService

To configure the OfficeService and ChartingService to do parallel requests change

the two properties files :

“ChartingPool.properties”•

“OfficePool.properties”•

Configuring “ChartingPool.properties”

Open the “ChartingPool.properties” file located in the [QPP Server]/conf1.

folder
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Set the chartingThread.pool.maxActive property to specify the maximum2.

number of threads that can be active at any given moment.

Set the chartingThread.pool.whenExhaustedAction property to specify3.

what should be done if the pool size has already been reached.

Set to 0 to return immediately throwing a NoSuchElement exception.•

Set to 1to block for some time depending on value of maxWait for an•

available thread.

Set to 2 to increase the size of the pool and return a new thread instance.•

Set the chartingThread.pool.maxWait property to specify the amount of4.

time in milli-seconds for which to wait for an available thread. Set to -1 to wait

indefinitely.

Set the chartingThread.pool.maxIdle property to specify the maximum no5.

of idle threads in the pool.

Set the chartingThread.pool.minIdle property to specify the minimum no6.

of idle threads in the pool.

Set the chartingThread.pool.minEvictableIdleTimeMillis property to7.

specify the minimum time in milli-seconds for a thread to be in the pool before

it can be evicted.

Set the chartingThread.pool.timeBetweenEvictionRunsMillis property8.

to specify the time in milli-seconds after which the evictor thread should run to

remove idle thread. Set to -1 to indicate Never.

Configuring “OfficePool.properties”

Open the “OfficePool.properties” file located in the [QPP Server]/conf folder1.

Set the officeThread.pool.maxActive property to specify the maximum2.

number of threads that can be active at any given moment.

Set the officeThread.pool.whenExhaustedAction property to specify what3.

should be done if the pool size has already been reached.

Set to 0 to return immediately throwing a NoSuchElement exception.•

Set to 1to block for some time depending on value of maxWait for an•

available thread.

Set to 2 to increase the size of the pool and return a new thread instance.•

Set the officeThread.pool.maxWait property to specify the amount of time4.

in milli-seconds for which to wait for an available thread. Set to -1 to wait

indefinitely.

Set the officeThread.pool.maxIdle property to specify the maximum no of5.

idle threads in the pool.

Set the officeThread.pool.minIdle property to specify the minimum no of6.

idle threads in the pool.
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Set the officeThread.pool.minEvictableIdleTimeMillis property to7.

specify the minimum time in milli-seconds for a thread to be in the pool before

it can be evicted.

Set the officeThread.pool.timeBetweenEvictionRunsMillis property to8.

specify the time in milli-seconds after which the evictor thread should run to

remove idle thread. Set to -1 to indicate Never.

QuarkXPress Server Filter

To adjust QuarkXPress filter settings:

Open the “QxpsFilterServiceConfig.properties” file located in the [QPP1.

Server]/conf folder.

Set the qxpsfilter.useSpreadForArticles= value to true to specify that2.

previews for articles are generated for each spread.

Set the qxpsfilter.useSpreadForProjects= value to true to specify3.

project previews with spreads.

By default, XML deconstruction is enabled. The default setting for the4.

qxpsfilter.generateDeconstructedXML= entry is true. To disable XML

deconstruction, set the entry to false.

By default, Full Text Search (FTS) is enabled. The default setting for the5.

qxpsfilter.generateText= entry is true. To disable FTS, set the entry to

false.

A true value for qxpsfilter.generateDeconstructedXML also enables FTS
for QuarkXPress projects and QuarkCopyDesk articles. Text generation is

dependent on XML generation. If you set generateDeconstructedXML to

false, Quark recommends also setting qxpsfilter.generateText to false.

To specify the scale of preview images, adjust the qxpsfilter.previewScale=6.

value. The default value of 1 indicates previews at 100 percent. The values of 2,

3, and 6 are 200 percent, 300 percent, and 600 percent, respectively.

To specify the scale of thumbnail images, adjust the7.

qxpsfilter.thumbnailScale= value. The default value of 1 indicates

previews at 100 percent. The values of .5, 2, 3, and 6 are 50 percent, 200

percent, 300 percent, and 600 percent, respectively.

To specify image quality for JPEG previews, adjust the8.

qxpsfilter.jpegQuality= value. Enter 1 for the highest quality, 2 for high

quality, 3 for medium quality, and 4 for lowest quality.

Save and close “QxpsFilterServiceConfig.properties.”9.

JAWS filter settings

The JAWS filter is part of the ImageMagick® Filter Service Configurations for EPS,

PDF, and Adobe® Illustrator® files. To specify settings for the JAWS filter:

Open the “JawsFilterServiceConfig.properties” file located in the [QPP1.

Server]/conf folder.
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To specify the resolution for thumbnails and previews (measured in dots-per-2.

inch), adjust the jawsfilter.resolution= value.

The jawsfilter.resolution= value is the fallback resolution used to scale
the preview image to the specified size when the proper resolution cannot be

calculated.

Save and close “JawsFilterServiceConfig.properties.”3.

XML Author filter settings

The XML Author filter is part of the configuration for XML files. XADocFilter is used

to generate Previews and Thumbnails of XML files. To specify settings for the XML

Author filter:

Open the “XADocFilterServiceConfig.properties” file located in the [QPP1.

Server]/conf folder.

To specify the amount of time a process will wait for indexing (with2.

XADocFilter) to complete, adjust the xaDocfilter.processTimeOut= value.

To specify the preview height and width, adjust the3.

xaDocfilter.previewHeight= value and the

xaDocfilter.previewWidth= value.

To specify the maximum number of pages for which a preview should be4.

generated, adjust the xaDocfilter.previewPages= value.

Save and close “XADocFilterServiceConfig.properties.”5.

ImageMagick, Jaws, and DITA OT directories

By default, ImageMagick, Jaws, and the DITA Open Toolkit are included with Quark

Publishing Platform. However, if you have existing installations of ImageMagick or

Jaws, perform the following tasks:

Open the “ServerApp.properties” file located in the [QPP Server]/conf1.

folder.

Scroll to the IMAGE_MAGICK_HOME= entry.2.

Enter the path to your existing ImageMagick bin folder.3.

Scroll to the JAWS_HOME= entry.4.

Enter the path to your existing Jaws bin folder.5.

Scroll to the DITA_HOME= entry.6.

Enter the path to your existing DITA Open Toolkit folder.7.

Save and close “ServerApp.properties.”8.

Full text indexing configuration

To configure FTSIndex filter settings:
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Open the “LuceneTextIndexingConfig.properties” file located in the [QPP1.

Server]/conf folder.

By default, the storage location for index files is in the Quark Publishing2.

Platform installation folder. However, you can change the location by changing

the lucene.index.dir= parameter to indicate the folder in which you want to

store index files.

Specify the language (class) used most frequently for text indexing and query3.

term analysis by changing the lucene.analyzerClass= parameter. The

default setting — StandardAnalyzer — recognizes English semantics for Full

Text Search. But if the majority of the text in your workflow is not English, you

can specify another language to search more accurately according to that

language’s semantics. The languages are listed in the

“LuceneTextIndexingConfig.properties” file.

“LuceneTextIndexingConfig.properties” contains information for each
parameter, as well as links to the Apache documentation.

To specify the number of changes after which an index compaction should be4.

performed, set a value for lucene.maxModificationWithoutOptimisation.

Save and close “LuceneTextIndexingConfig.properties.”5.

Charting Service

To configure the properties for the Charting service modify the below properties:

Enter the default output format (PDF/HTML/IMAGE/JSON) in the1.

charting.defaultOutputFormat parameter.

Enter the default values for the image output properties in the following2.

parameters:

charting.defaultImageFormat=png•

charting.defaultWidth=600•

charting.defaultScale=•

Enter the path to the default HTML template:3.
charting.defaultHTMLTemplateURI=classpath\:DefaultHTMLTemplate
.html 

Integrating QLA with Quark Publishing Platform

To reconfigure Quark® License Administrator (QLA) primary and backup server

settings with Quark Publishing Platform:

Open the “Qla.properties” file located in the [QPP Server]/conf folder.1.

Enter the current IP address or hostname of the computer where you installed2.

QLA in the QlaServer.machinename= parameter.

Enter the port number in the QLAServer.port= parameter.3.
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If you have a backup QLA server, enter the correct IP address or hostname and4.

port values in the Backup.QlaServer.machinename= and

Backup.QlaServer.port= parameters.

In the Qla.SerialNumber= parameter, enter the QLA serial number for Quark5.

Publishing Platform Server. The QLA Server Console and QLA Client

applications display your serial number.

The serial number is updated in “Qla.properties” based on the validation code
that you provided when you installed or updated Quark Publishing Platform

Server.

Save and close “Qla.properties.”6.

Dynamic configuration

The Configuration service is used to manage publishing configuration:

Adding/updating new publishing channels•

Adding/updating new publishing process•

Adding/updating new MIME types for content type•

The Configuration service is responsible for the following:

Managing the configuration files.•

Capturing updates.•

Reinitializing corresponding bean definitions, avoiding restarts.•

Using the reinitialize API to avoid restarts even after changing the configuration•

files manually on the server .

In a multi-server environment, each node in a cluster must have access to a single

.ext folder and the shared location must be appended to the classpath system

environment variable.

Creating a custom XML mime-type

https://http://localhost:61400/rest/service/config/xmlmimetypes?
op=create&mimetype=application/xml;
format= researchreport&parentmimetype=application/xml;
format= smartcontent&xpath =/*[local-name()=’section’]/@type=’
researchreport

Mapping the XML mime-type to a content type in Platform

https://http://localhost:61400/rest/service/config/xmlmimetypes?
op=mapcontenttype&contenttype=Research
Report&mimetypes=application/xml;
format=researchreport

Creating Publishing Channels

https://http://localhost:61400/rest/service/config/publishingchan
nels?
op=create&publishingchannellist=<publishingChannelList><publishin
gChannelInfoid=”researchReportPdf”
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Defining Publishing Channels for Asset indexing

https://http://localhost:61400/rest/service/config/publishingchan
nels?
contenttype=Research Report&loginname=Admin&loginpassword=Admin

Enabling IPTC support

IPTC values in a picture file can be recognized and included in the picture’s attribute

list. To enable or disable IPTC functionality, open the file

\Server\conf\IMFilterServiceConfig.properties and set the

imfilter.generateIPTCAttributes property to true or false. You can also

specify preview/thumbnail resolution by setting a value for

imfilter.resolution.

Failover setup

This topic describes one way you can configure a Quark Publishing Platform

installation for failover.

The key to a setup like this is to use a virtual IP address for the Quark Publishing

Platform Server computer.

Failover setup: Normal operation

During normal operations, the Production site is up and running and the virtual IP

address is mapped to that server. The DR (disaster recovery) site is in dormant mode,
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with all Quark Services stopped. The following things are being synchronized from

the Production servers to the DR server:

Quark Publishing Platform repository folder(s)•

Quark Publishing Platform database•

QPP Server/conf folder•

QPP Server/Index folder•

Synchronization of the Quark Publishing Platform File Server folder(s) and Quark
Publishing Platform Oracle database must be done at the same time and at the same

intervals to maintain data integrity.

If the Production site goes down, synchronization stops and the virtual IP address is

re-mapped to the DR site. End users should not notice the change because they are

still using the same virtual IP address.

Failover setup: Production server goes down

At this point, an administrator should perform an orderly shutdown of the DR site,

then restart synchronization from the DR site to the Production site.
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Failover setup: Synchronizing from DR site to Production site

When synchronization is complete between the DR site and the Production site,

remap the virtual IP address to the Production site, reverse the synchronization so

that changes are pushed from the Production server to the DP site, and then launch

all of the Quark Publishing Platform components.
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Failover setup: Normal operation restored

Encrypting a plain text password

In Quark Publishing Platform 10.1 and later, you can encrypt all of your passwords

that are in plain text. For example, if you are using an SQL Server or Oracle as a

database in the Platform Server then your database user password is stored in plain

text in the “database.properties” file. You can encrypt this password.

To encrypt plain text passwords:

Open the command prompt and navigate to the Platform server installation1.

folder.

Launch the “encrypt.bat” file with your password (encrypt.bat password) to2.

retrieve its encrypted value.

Copy the generated encrypted value of the password and use this encrypted3.

value in any of properties file (for example, “database.properties”).

Open the “lib” folder in your Quark Publishing Platform Server folder.4.

Open “qpp-server-app-13.2.jar” and navigate to \com\quark\qpp\app inside5.

the jar file.

Open “ServerStartupContext.xml “ in a text editing application and under the6.

securePlaceholderConfig node, add an entry for each of the properties file

that you used the encrypted value in. Remove this entry from the

placeholderConfig node if it exists.
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Save the file, update the jar and restart the server.7.

You can use any of the algorithms mentioned in the
“ServerStartupContext.xml” file and you can modify the key used to encrypt

the password (default is QUARK).

Enabling forced log off during inactivity

Configuring WebAdmin to enable forced log off

Forced Log off can be enabled by engaging a predefined Servlet Filter in the

“Web.xml” file in the [QPP Server]/webapps/admin folder:

session-idle-time: Specifies the time (in seconds) of inactivity after which a•
user will be forced to log off of WebAdmin.

exclude-url-patterns: Specifies URL patterns which are not considered user•
activity.

pre-expiry-mag-time: Specifies the time (in seconds) before pending•
inactivity bases log off, a warning or countdown message will be shown.

<filter>
<filter-name>SessionTimeoutCookieFilter</filter-name>
<filter-

class>com.quark.web.activity.servlet.SessionTimeoutCookieFilter</
filter-class>

<init-param>
<param-name>session-idle-time</param-name>
<param-value>60</param-value>  

</init-param>
<init-param>

<param-name>exclude-url-patterns</param-name>
<param-value>/admin/keepAlive.qsp</param-value>  

</init-param>
<init-param>

<param-name>pre-expiry-mag-time</param-name>
<param-value>40</param-value> 

</init-param>
</filter>
<filter-mapping>

<filter-name>SessionTimeoutCookieFilter</filter-name>
<url-pattern>/*</url-pattern>

</filter-mapping>
Forced log off can also be enabled in the “Admin-Home.jsp” file in QPP
Home/webapps/admin/jsp folder:

<!— Uncomment for “Forced Logoff on Inactivity” —>
<script type=”text/javascript”

src=”resources/js/SessionTimer.js></script>
<link type=”text/css” href=”resources/js/SessionTimer.css

re;=”stylesheet></link>
function logoutDueToInactivity ()  {

window.location.href = “logout.qsp”;
};
<%— Initialise inactivity monitor —%>
SessionTimer.init(logoutDueToInactivity);

Configuring Workspace to enable forced log off
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Forced log off can be enabled by engaging a predefined Servlet Filter in the

“Web.xml” file in the [QPP Server]/webapps/workspace folder:

session-idle-time: Specifies the time (in seconds) of inactivity after which a•
user will be forced to log off of WebAdmin.

exclude-url-patterns: Specifies URL patterns which are not considered user•
activity.

pre-expiry-mag-time: Specifies the time (in seconds) before pending•
inactivity bases log off, a warning or countdown message will be shown.

<filter>
<filter-name>SessionTimeoutCookieFilter</filter-name>
<filter-

class>com.quark.web.activity.servlet.SessionTimeoutCookieFilter</
filter-class>

<init-param>
<param-name>session-idle-time</param-name>
<param-value>300</param-value>  

</init-param>
<init-param>

<param-name>exclude-url-patterns</param-name>
<param-

value>/workspace/keepAlive.qsp/workspace/assetHeaderUpdate.qsp</p
aram-value>  

</init-param>
<init-param>

<param-name>pre-expiry-mag-time</param-name>
<param-value>60</param-value> 

</init-param>
</filter>
<filter-mapping>

<filter-name>SessionTimeoutCookieFilter</filter-name>
<url-pattern>/*</url-pattern>

</filter-mapping>
Forced log off can also be enabled in the “User-Home.jsp” file in QPP
Home/webapps/workspace/jsp folder:

<!— Uncomment for “Forced Logoff on Inactivity” —>
<script type=”text/javascript”

src=”resources/js/SessionTimer.js></script>
<link type=”text/css” href=”resources/js/SessionTimer.css

rel=”stylesheet></link>
<%— Initialise inactivity monitor —%>
SessionTimer.init(UserHomeUI.logout);
The countdown message will be shown with remaining seconds. The user can

prevent the forced log off by clicking Continue Session.

Forced log off countdown
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Configuring messaging

To configure Quark Publishing Platform Server to display Asset Workflow
Changed messages when any listed attribute is changed on the related asset:

Open the “AssetWorkflowChangedMessageAttributes.xml” file located in the1.

[install_path]/Server/conf/ folder.

Set the attributes IDs or names to trigger the Asset Workflow Changed2.

message when any listed attribute is changed on the related asset.

<!— List of attribute ids or names to be considered for “ASSET
WORKFLOW CHANGED MESSAGE”
The “ASSET WORKFLOW CHANGED MESSAGE” will be published if
there is any changes in the attributes
of the mentioned asset/>

<util:list id=”assetWorkflowAttributes”>
<value>name</value> 
<value>Status</value> 
<value>Workflow</value>
<value>Routed to</value> 

</util:list>
</beans>

Configuring clipboard service

Use the “ClipboardConfig.xml file” to configure the clipboard service. This file

contains format conversion detail.

ClipboardFormat: Represents a clipboard data format with the format name•
and its mime-type.

ClipboardFormats: Represents all possible clipboard data formats.•

ChannelMapping: Represent a binding of the publishing channel with the given•
clipboards data format. The given channel will be used to generate the clipboard

data format specified in the attribute clipboardformat.

ChannelMappings: A default set of all publishing channel to clipboard data•
formats mappings.

<ClipboardConfig>
<ClipboardFormats>

<ClipboardFormat>
<name>svg</name>

<mimeType>image/svg+xml</mimeType>
</ClipboardFormat>
…
…

</ClipboardFormats>
<ChannelMappings>  

<ChannelMapping id=”fetchExcelTable”
contenttype=”Microsoft Excel Table”  clipboardformat=”svg”>

<param name=”OUTPUT_FORMAT”>image</param>
<param

name=”OUTPUT_FORMAT_PROPERTIES”>imageformat=svg</param>
</ChannelMapping>
…
…

</ChannelMappings>
</ClipboardConfig>
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Enable tracing and printing of JVM information

se the following debugging options in the “wrapper.conf” file located in the server

installation folder, to enable tracing and printing of the JVM information:

wrapper.java.additional.7=-XX:+HeapDumpOnOutOfMemoryError :•
Dumps heap to a file when java.lang.OutOfMemoryError is thrown. 

wrapper.java.additional.8=-XX:HeapDumpPath=.\log\ :  Sets the path•
to directory or filename for heap dump.

wrapper.java.additional.9=-XX:ErrorFile=.\log\hs_err_pid%p.log :•
If an error occurs or JVM crashes, save the error data to this file.

Configuring location of the publishing rescue folder

Configure the path used to store the QuarkXPress Server publishing rescue folder,

where publishing data is to be saved in the case of any publishing failure. If a path

is not specified, a default rescue folder named “PublishingRescueFolder”,   will be

created in the current working directory.

There are two ways to confiure the path:

Edit the “PublishingUtilContext.xml” file ([install-1.

path]/Server/publishing) to configure the path.

This method requires a server restart.

<propertyname=”rescueFolderPath” value=”C:\Program
Files\Quark\Quark Publishing
Platform\Server\MyCustomPublishingRescueFolder”/>
Use JConsole as shown below:2.

No server restart is required with this method.
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Quark Publishing Platform Web
Client — Manual configuration

The following sections describe how to configure the advanced settings of Quark

Publishing Platform Web Client.

Configuration overview

The workspace configuration is organized into two categories:

Application level settings•

Document level settings•

These are set in the “Workspace-Config.xml” configuration file in the [QPP
Server]/ webapps /workspace/WEB-INF/classes folder.

Application level settings

The attribute elements of ApplicationSettings defines various application level

settings:

userNameFormatting: Specifies the format of the user name to be displayed in•
all dialogs:

0 to display log on name <username>1.

1 to display <First Name> <Last Name>2.

2 to display <Last Name>, <First Name>3.
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layoutPreview: Specifies the look and feel of the preview window for assets•
belonging to the QuarkXPress content type:

True to display the preview in a separate browser window1.

False to display the preview in a javascript window instead of a browser.2.

viewrevision_expandAll: Specifies whether all revision comments need to be•
expanded in the view revisions dialog.

supported_picture_extension: Specifies the possible file types allowed when•
importing a picture/text in the article/project editors.

picture_editing_extension: Specifies the possible file formats allowed when•
editing pictures in the article/project editors.

defaultPreviewScale: Specifies the default zoom preview setting to be used•
when editing articles/projects and viewing assets (live preview). Valid values for

this parameter range from 0.1 to 5.

ajaxTimeout: Specifies the time period for all background requests originating•
from browser after which the requests will be marked as timed out. The value is

specified in milliseconds.

showFormView: Specifies whether to show the form view panel in the Check In•
dialog. Set to true to show the form view pane.

topBannerJspPath: Specifies the path to the .jsp file to be included to show•
the top banner in the assignment page.

logoFilePath: Specifies the path to the logo image shown in the top banner in•
the assignment page.

enabledPublishingChannels: Defines the list of publishing channels that•
need to be honored when selecting an asset.

enableDeliveryChannels: Defines whether delivery channels needs to be•
enabled or not.

enabledDeliveryChannels: Defines the list of delivery channels that need to•
be honored when selecting an asset. This would get enabled when the

enableDeliveryChannels option is set to true.
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allowPublishedRenditionDownload: Defines whether to allow the download•
output displayed for the various previews using the publishing defined for the

selected asset.

<ApplicationSettings>
<Add key=”viewrevision_expandAll” value=”false”/>
<Add key=”supported_picture_extension”

value=”bmp;jpg;jpeg;tif;tiff;gif;”/>
<Add key=”picture_editing_extension”

value=”jpg;jpeg;tif;tiff;eps”/>
<Add key=”userNameFormatting” value=”0”/>
<Add key=”layoutPreview” value=”true”/>
<Add key=”defaultPreviewScale” value=”0.8”/>
<Add key=”ajaxTimeout” value=”300000”/>
<Add key=”showFormView” value=”false”/>
<Add key=”topBannerJspPath” value=”Header.jsp”/>
<Add key=”logoFilePath” value=”images/login/topbanner-

innerpage-left.png”/>
<Add key=”enabledPublishingChannels”

value=”qxpPdf;qxpEpub;qxpAppStudio;qxpAppStudioPackage;busDocPdf;
busDocHtml;busDocQxp/>

<Add key=”enableDeliveryChannels” value=”false”/>
<Add key=”enabledDeliveryChannels”

value=”checkInToSharepoint;checkInToFileNet;checkInToDocumentum;s
endEmail;sendToFTPServer”/>

<Add key=”allowPublishedRenditionDownload” value=”true”/>
</ApplicationSettings>

Multi-Channel preview

For each content type you will specify the publishing channels that should be

available to the user in the Preview tab of the assignment page. Publishing

channels for preview are configured using the <PreviewSettings> element:

displayName: Specifies the channel name displayed in the user interface•
(optional). If not given, then outputFormat is used.

Id: Specifies the Publishing Channel Id as defined in the Platform Server.•

ContentType: Specifies the content type of the asset .•

ApplyToChildContentTypes: Specifies whether to include the child content•
types.

outputFormat: Supported values:•

IMAGE_ARCHIVE: An image archive for the published output, which will1.

be rendered inside a web page.

HTML_ARCHIVE: An HTML archive for the published output, which will be2.

rendered as is, pointing to the file name present in the HTML Archive.

PDF_ARCHIVE: The published output PDF, which will be rendered as is.3.

downloadChannel: (optional) Used in case a different channel needs to be•
invoked for download of selected channel preview.

<PreviewSettings>
<ChannelMappings>

<ChannelMapping contentType =”Business Document”
applyToChildContentTypes =”true”>

<Channels>
<Channel id=”busDocPdf” outputFormat=”PDF_ARCHIVE”
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displayName=”PDF”/>
<Channel id=”busDocHtml” outputFormat=”HTML_ARCHIVE”

displayName=”HTML”/>
<Channel id=”busDocJpeg” outputFormat=”IMAGE_ARCHIVE”

displayName=”IMAGE”/>
</Channels>

</ChannelMapping>
<ChannelMapping contentType=”Smart Content”

applyToChildContentTypes=”true”>
<Channels>

<Channel id=”smartDocPdf” outputFormat=”PDF_ARCHIVE”
displayName=”PDF”/>

<Channel id=”smartDocHtml” outputFormat=”HTML_ARCHIVE”
displayName=”HTML”/>

<Channel id=”smartDocJpeg” outputFormat=”IMAGE_ARCHIVE”
displayName=”IMAGE”/>

</Channels>
</ChannelMapping>

</ChannelMappings>
</PreviewSettings>

Attributes for General pane

The attributes for the General tab are configured using the <PreviewAttributes>
element. The values specify the list of attributes to be displayed in the General tab

for the selected asset.

<PreviewAttributes>
<PreviewAttribute>Id</PreviewAttribute>
<PreviewAttribute>Created</PreviewAttribute>
<PreviewAttribute>Last modified</PreviewAttribute>
<PreviewAttribute>Creator</PreviewAttribute>
<PreviewAttribute>Last modifier</PreviewAttribute>
<PreviewAttribute>Status</PreviewAttribute>
<PreviewAttribute>Collection</PreviewAttribute>
........

</PreviewAttributes>
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Role based Toolbar configuration

This section describes how to define the toolbar items for a desired role. Role based

configuration for toolbar items are configured using the <ToolbarConfig>
element.

Role name: Specify the name of role whose configuration is to be defined.•

Item ID: Specify the id of the item whose appearance needs to be configured.•

showInToolbar: To hide the menu item in the toolbar, set this attribute to false.•

showInContext: To hide the menu item in the context menu, set this attribute•
to false.

showInNewMenu: To hide the menu item in the New Asset menu, set this•
attribute to false.

showInTemplateMenu: If the menu item is not to be shown in the New Asset•
from Template, set this attribute to false.

The following is the XML structure of the toolbar configuration:

<Role name =”[ROLE NAME]”>
<Item id =”[ITEM ID]”

showInToolbar =”[true/false (defaults to true)]”
showInContextMenu =”[true/false (defaults to true)]”
showInNewMenu =”[true/false (defaults to true)]”
showInTemplateMenu =”[true/false (defaults to true)]”/>

</Role> 
<ToolbarConfig>

<Role name =”Guest”>
<Item id =”new_qcd_menu_item”/>
<Item id =”new-search-btn”/>
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<Item id =”duplicate-asset” showInToolbar=”false”/>
<Item id =”delete-asset”/>
<Item id =”show-edit-attributes” showInContextMenu=”false”/>
<Item id =”show-Asset_preview” showInToolbar=”false”/>
........

</Role>
</ToolbarConfig> 
The Context menu for the Guest role will look like:

Context menu for Guest role

Toolbar items for the Guest role will look like:

Toolbar items for Guest role

Here is the list of item IDs:

checkin: Check in the Asset•

show-check-out: Check out the Asset•

cancel-checkout: Cancel Asset Check out•

get-asset: Get Asset•

new-search-btn: New Search (not available as Context Menu Item)•

show-Asset-Preview: Preview Asset•

show-edit-attributes: Edit Asset Attributes•

attachment-info: Show Attachment Information•

view-revisions: View Asset Revisions•

duplicate-asset: Duplicate Asset•

delete-asset: Delete Asset•

reindex-asset: Reindex Asset (not shown in Toolbar by default)•

publish-menu-btn: Publish an asset•

deliver-menu-btn: Deliver an asset•

restore: Restore assets•
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archive-asset: Archive assets•

open-collection: Open the collection to which the asset belongs•

refresh-datadoc: Refresh a datadoc•

unlink-datadoc: Unlink a datadoc•

open-readonly: Open asset as read-only•

new_qcd_menu_item: Create new QuarkCopyDesk Article•

new_qxp_menu_item: Create new QuarkXpressProject from template•

The showInToolbar and showInContextMenu attributes are only applicable for
menu items displayed in the toolbar and the context menus. For buttons configured

in the ui-extension.xml file, showInToolbar is not applicable, as the configuration is

meant for adding a toolbar button itself. Additionally the button can be added to

context menu, hence only showInContextMenu is applicable for ui-extension.xml

buttons. The showInNewMenu and showInTemplateMenu attributes are only

applicable for menu items in the New Asset menu dropdown, and are not

applicable while setting up role based configuration for ui-extension.xml menus in

this section.

The rest of the configurable elements specified in “Workspace-config.xml” are for
integration with Quark Author Web Edition. For more information, see Quark

Author Web Edition Configuration Guide.

Restricting access to Web Client/Admin

To restrict the webapp so that the workspace and admin pages can only be accessed

from within your own network, use a Tomcat Valve to restrict access based on an IP

address range.

Open the “server.xml” file located in the {install_path}/conf folder.1.

Edit the context elements corresponding to the admin and workspace2.

applications to engage a RemoteAddrValve. The valve has to be configured to

allow only intranet traffic. The final config would look something like the

following:

<Context path=”/qxpsm” docBase=”qxpsm”>
<Manager pathname=”“ />

</Context>
<Context path=”/workspace”docBase=”workspace”>

<Manager pathname=”“ />

<Valve className=”org.apache.catalina.valves.RemoteAddrValve”
allow=” 10\.91\..*\..* “/>
</Context>
<Context path=”/webservices”docBase=”webservices”>

<Manager pathname=”“ />
</Context>
<Context path=”/messaging” docBase=”messaging”>

<Manager pathname=”“ />
</Context>
<Context path=”/admin”docBase=”admin”>
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<Manager pathname=”“ />

<Valve className=”org.apache.catalina.valves.RemoteAddrValve”
allow=”  10\.91\..*\..*  “ />
</Context>
<Context path=”/rest”docBase=”rest”>

<Manager pathname=”“ />
</Context>

The value of the allow attribute is a regex for matching IP addresses. Here the
intranet IPs are assumed to be in 10.91.x.x range. You need to update this value

based on your network IP ranges.

Document save configuration

Attribute mapping and revision settings

The AttributeMapping element for each content type present in the workspace-
config.xml file allows you to:

Specify the document attributes that should be mapped to Platform attributes.•

Specify save configuration when a document is saved to the Platform Server.•

<AttributeMapping>
<ComponentTypes>

<ComponentType name=”Smart Section”>
<RevisionSettings>

<RevisionSetting operation=”SaveDocumentRevision”>
<SaveSilently>false</SaveSilently>
<SaveAsMinorVersion>false</SaveAsMinorVersion>

</RevisionSetting>
<RevisionSetting operation=”SaveDocument”>

<SaveSilently>false</SaveSilently >
<SaveAsMinorVersion>false</SaveAsMinorVersion>

</RevisionSetting>
<RevisionSetting operation=”ExportComponent”>

......
</RevisionSetting>
<RevisionSetting operation=”SaveComponent”>

......
</RevisionSetting>

</RevisionSettings>
<Attributes>

<Attribute name=”Text preview”
xpath=”/smart:section/smart:title”
indexingOption=”ALL_VERSIONS”/>

<Attribute name=”Global ID” xpath=”/smart:section/@id”
indexingOption=”ALL_VERSIONS”/>

<Attribute name=”File extension” value=”xml”
indexingOption=”ALL_VERSIONS”/>

......
</Attributes>

</ComponentType>
</ComponentTypes>

</AttributeMapping>
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Revision settings

The RevisionSettings element specifies the document versioning scheme (major

or minor) and configuration with regard to the Save dialog visibility while saving a

document.

Operation: supported values are:•

SaveDocument: Saving a document to the server. Settings value referred to1.

when a user clicks the Save and Close button in the Editor.

SaveDocumentRevision: Saving a document revision to the server.2.

Settings value referred to when a user clicks the Save button in the Editor.

ExportComponent: Exporting a section of this component type from3.

document of another component type and saving it as a document to the

server. Settings value referred to when a user executes a Create Component

operation in the Editor.

SaveComponent: Saving a component as a new document version to the4.

server. Settings value referred to when a component document is checked

out inline in the main document and then checked in.

SaveSilently: Specifies whether the document is saved without showing the•
Save dialog or not.

SaveAsMinorVersion: Specifies whether the document is saved as a minor•
version or not.

Attribute mapping

The Attributes element specifies the mapping of data from the document to the

Platform Server attributes. The values of the Platform attributes can be specified

either as static text or an XPath to the content in a document.

name: Specifies the name of the Platform Server attribute.•

value: Specifies the static attribute value.•

xpath: Specifies the XPath to be used for setting the Platform attribute value.•

You can either set XPath or a static value.

indexingOption: Supported values are:•

INITIAL_VERSION: Set this value to trigger indexing only for the first1.

version of the document. This is the default value of the indexingOption.

ALL_VERSIONS: Set this value to trigger indexing for every revision2.

inheritValueFromTemplate: Specifies whether the attribute value is inherited•
from the server template. The default value is false.

Attribute mapping configuration

If you want to configure some attributes so that attribute values are fetched from

the document for the “Smart Document” content type:

Update the Attributes key for content type ‘Smart Document’:•
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<Attributes>
<Attribute name=”Text preview”

xpath=”/smart:section/smart:title”
indexingOption=”ALL_VERSIONS”/>

<Attribute name=”Global ID” xpath=”/smart:section/@id”
indexingOption=”ALL_VERSIONS”/>

<Attribute name=”Title” xpath=”/smart:section/smart:title”
indexingOption=”ALL_VERSIONS”/>

<Attribute name=”File extension” value=”xml”
indexingOption=”ALL_VERSIONS”/>

<Attribute name=”TextAttr” 

xpath=”/smart:section/smart:body//smart:meta/smart:attribute[@
name=’disease’]/smart:value”

indexingOption=”ALL_VERSIONS”/>
<Attribute name=”DateAttr” value=”2014-08-14”

indexingOption=”ALL_VERSIONS”/>
<Attribute name=”NumberAttr” value=”15”

indexingOption=”ALL_VERSIONS”/>
<Attribute name=”BooleanAttr” 

xpath=”/smart:section/smart:body//smart:meta/smart:attribute[@
name=’transmission’]/smart:value”

indexingOption =”ALL_VERSIONS”/>
<Attribute name=”DateTimeAttr” 

xpath=”/smart:section/smart:body//smart:meta/smart:attribute[@
name=’host’]/smart:value”

indexingOption =”ALL_VERSIONS”/>
</Attributes>
When a document of type “Smart Document” is checked in, the value of

attributes like Text preview and Title are fetched from the document based

on the XPath and get saved along with the document.
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Quark Publishing Platform Clients —
Manual configuration

You can change a variety of configuration options for Quark Publishing Platform

clients and Platform XTensions after installation. See the following topics for more

information.

Creating and maintaining the log file (macOS only)

The setting to create and maintain the log file is mentioned in the

com.quark.qpp.client.Quark.QPP.Client.config.plist file. This file can

be found here: ~/Library/Preferences\Quark\QPP\{version}.

To change the location of the log file, define the new log location using the

LogFileName attribute. The default log location is ~/Library/Logs/Quark
Publishing Platform Client.Log

To change the log file size, define the new size using the LogFileSize attribute.

Users can enable and disable the logging of exceptions using the LogException
attribute.

The supported values are:

(NO) Disables the exception logging•

(YES) Enables the exception logging•

Creating and maintaining the log file (Windows only)

The setting to create and maintain the log file is mentioned in the

Quark.QPP.Client.config file. This file can be found where the application is

installed. Users can enable and disable logging using the QPSLogIsEnabled
attribute.

The supported values are:

0 (NO)•

1 (YES)•

To change the location of the log file, define the new log location using the

QPSLogFile attribute. The default log location:

for Quark Publishing Platform client is AppData\Quark Inc\Quark•
Publishing Platform\{version}\Logs 
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for Platform Client related operations in QuarkXPress is•
AppData\Roaming\Quark Software Inc\QuarkXPress
{version}\{version}\Logs

To change the size of the log file size, define the new size using the

QPSLogFileSize attribute. The size is defined in Bytes. The default value of the

Out of the Box config is 5242880 bytes.

Use the QPSLogFileMode attribute to specify how the log file is written.

Allowed values are:

1 (CreateNew). Specifies that the operating system should create a new file. If the•

file already exists, a System.IO.IOException is thrown.

2 (Create). Specifies that the operating system should create a new file. If the file•

already exists, it will be overwritten.

3 (Open). Specifies that the operating system should open an existing file. If the•

file does not exist, a System.IO.FileNotFoundException is thrown.

4 (OpenOrCreate). Specifies that the operating system should open a file if it•

exists, otherwise, a new file should be created.

5 (Truncate). Specifies that the operating system should open an existing file.•

Once opened, the files should be truncated so that the file size is zero bytes.

6 (Append). Opens the file if it exists and seeks to the end of the file, or creates a•

new file.

FileMode - OpenOrCreate (4) allows one to open a file with the following access :
FileAccess.Read, FileAccess.Write, FileAccess.ReadWrite, FileAccess.Append.

Attempting to read from a file opened with FileMode - Truncate (5) will throw an

exception.

The QPSLogFileShare provides the option to restrict or share the log file created

with other processes.

Allowed values are:

0 (None). Declines sharing of the current file.•

1 (Read). The default value. Allows opening of the file for reading.•

2 (Write). Allows opening of the file for writing.•

3 (ReadWrite). Allows opening of the file for reading or writing.•

4 (Delete). Allows subsequent deleting of a file.•

16 (Inheritable). Makes the file handle inheritable by child processes.•

To specify the maximum number of backup log files us the

QPSLogFileBackupNumber attribute.

Creating and maintaining the log file (Quark XML Author for Platform)

The following configuration in the Quark.CMSAdapters.config file allows the

system integrator or user to set the log file path:

<!— Defines log file path.—>
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<add key=”LogFilePath” value=”%APPDATA%\Quark\XML
Author\Logs\CMS Adapter Log.txt”/>

The setting to create and maintain the log file is mentioned in the

Quark.QPP.Client.config file. This file can be found in the application folder.

Users can enable and disable logging using the QPSLogIsEnabled attribute.

The supported values are:

0 (NO)•

1 (YES)•

To change the location of the log file, define the new log location using the

LogFilePath attribute. The log location is AppData\Quark\XML
Author\Logs\CMS Adapter Log.txt

To change the size of the log file size, define the new size using the

QPSLogFileSize attribute. The size is defined in Bytes. The default value is

5242880 bytes.

Use the QPSLogFileMode attribute to specify how the log file is written.

Allowed values are:

1 (CreateNew). Specifies that the operating system should create a new file. If the•

file already exists, a System.IO.IOException is thrown.

2 (Create). Specifies that the operating system should create a new file. If the file•

already exists, it will be overwritten.

3 (Open). Specifies that the operating system should open an existing file. If the•

files does not exist, a System.IO.FileNotFoundException is thrown.

4 (OpenOrCreate). Specifies that the operating system should open a file if it•

exists, otherwise, a new file should be created.

5 (Truncate). Specifies that the operating system should open an existing file.•

Once opened, the files should be truncated so that the file size is zero bytes.

6 (Append). Opens the file if it exists and seeks to the end of the file, or creates a•

new file.

FileMode - OpenOrCreate (4) allows one to open a file with the following access :
FileAccess.Read, FileAccess.Write, FileAccess.ReadWrite, FileAccess.Append.

Attempting to read from a file opened with FileMode - Truncate (5) will throw an

exception.

The QPSLogFileShare provides the option to restrict or share the log file created

with other processes.

Allowed values are:

0 (None). Declines sharing of the current file.•

1 (Read). The default value. Allows opening of the file for reading.•

2 (Write). Allows opening of the file for writing.•

3 (ReadWrite). Allows opening of the file for reading or writing.•

4 (Delete). Allows subsequent deleting of a file.•
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16 (Inheritable). Makes the file handle inheritable by child processes.•

Suppressing the accessibility services warning - macOS

By default, an alert indicating that “Accessibility services are not enabled” may

display at launch in Quark Publishing Platform Client for macOS. To prevent this

warning from displaying:

Control+click the Quark Publishing Platform Client application icon and1.

choose Show Package Contents. A new window displays.

Open the “Info.plist” file in a text editor.2.

Locate the following lines:3.

<key>QPPDisableAccessibilityWarning</key>
<string>0</string>
Change the zero in the <string> element to a 1.4.

Displaying revision comments

By default, when you display the View Revisions dialog box, you must expand each

revision to see its revision comments. To make revision comments display

automatically on macOS:

Navigate to ~/Library/Preferences/Quark/QPP/[QPP Framework1.

Version].

Open the file named “com.quark.qpp.client.[Application Name].config.plist” in2.

a text editor.

Locate the following lines:3.

<key>ExpandAllRevisionComments</key>
<false/>
Change the <false/> element to <true/>.4.

On Windows, open the “[application name].exe.config” file, locate the following

line, and change the zero to a 1.

<add key =”ExpandAllRevisionComments” value=”0”/>

Displaying first and last names

You can configure Quark Publishing Platform to show user names in one of three

ways:

[username]•

[username] ([first name] [last name])•

[username] ([last name], [first name])•

To change this setting:

For Quark Publishing Platform Client for macOS, open the file•
~/Library/Preferences/Quark/QPP/[QPP Framework
Version]/com.quark.qpp.client.{Application}.config.plist, locate
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the following text, and set the <string> value to 0 for [username], 1 for

[username] ([first name] [last name]), or 2 for [username] ([last
name], [first name]):

<key>UserNameFormattingStyle</key>
<string>0</string>

For Quark Publishing Platform Client for Windows, open the “Quark•

Publishing Platform Client.exe.config” file (in the Quark Publishing Platform

Client application folder), locate the following text, and set the value attribute

to DEFAULT for [username], FIRSTNAME_LASTNAME for [username] ([first
name] [last name]), or LASTNAME_FIRSTNAME for [username] ([last
name], [first name]).

<add key=”UserNameFormattingStyle” value=”DEFAULT”/> 
For QuarkXPress for macOS, open the file•
~/Library/Preferences/Quark/QPP/[QPP Framework
Version]/com.quark.qpp.client.{Application}.config.plist, locate

the following text, and set the <string> value to 0 for [username], 1 for

[username] ([first name] [last name]), or 2 for [username] ([last
name], [first name]):

<key>UserNameFormattingStyle</key>
<string>0</string>

For QuarkCopyDesk for macOS, open the file•
~/Library/Preferences/Quark/QPP/[QPP Framework
Version]/com.quark.qpp.client.{Application}.config.plist, locate

the following text, and set the <string> value to 0 for [username], 1 for

[username] ([first name] [last name]), or 2 for [username] ([last
name], [first name]):

<key>UserNameFormattingStyle</key>
<string>0</string>

For QuarkXPress and QuarkCopyDesk for Windows, open the•

“Quark.QPP.client.config” file (in the application folder), locate the following

text, and set the value attribute to DEFAULT for [username],

FIRSTNAME_LASTNAME for [username] ([first name] [last name]), or

LASTNAME_FIRSTNAME for [username] ([last name], [first name]).

<add key=”UserNameFormattingStyle” value=”DEFAULT”/> 

Changing the preview font and size (Windows only)

To change the font and size used for attribute values to a font other than the default

search palette font and size, add the following key to the <appSettings> section of

the “Quark Publishing Platform Client.exe.config” file, with the desired font and

size in the “value” attribute:

<add key=”FontName_Text Preview” value=”Arial, 18”/>

Setting maximum number of assets to be fetched (Windows only)

To change the maximum number of assets fetched per collection when the user

performs a Get Asset command or a Get Collection command, add the

following key to the <appSettings> section of the “Quark Publishing Platform

Client.exe.config” file, with the desired number in the “value” attribute:
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<add key=”MaximumAssetFetchPerCollection” value=”50”/>
The default value is 50.

Specify whether to use Chunked Encoding (Windows only)

To specify whether or not to use Chunked Encoding when transferring files on

HTTP, add the following key to the <appSettings> section of the “Quark

Publishing Platform Client.exe.config” file. Supported values are 0 and 1.

<add key=”UseChunkedEncoding” value=”0”/>
The default value is 0.

Specify support for lazy loading when searching (Windows only)

To specify support for the lazy loading strategy for searching, add the following key

to the <appSettings> section of the “Quark Publishing Platform

Client.exe.config” file, with the desired strategy in the “value” attribute:

<add key=”LazyLoadingMode” value=”LAZY_LOADING_SCROLLBAR”/>
The supported values are:

NO_LAZYLOADING: All assets at once configured by the chunk size.•

LAZY_LOADING_HYPERLINK: The results specified are retrieved based on the•
chunk size, when the results specified by the chunk size are retrieved, a

hyperlink would appear to enable fetching the next chunk of results.

LAZY_LOADING_SCROLLBAR: The results specified are retrieved based on the•
chunk size, the scroll bar would enable fetching the next chunk of results.

The default value is LAZY_LOADING_SCROLLBAR.

Setting the lazy loading chunk size (Windows only)

To change the chunk size of the lazy loading search results to be fetched, add the

following key to the <appSettings> section of the “Quark Publishing Platform

Client.exe.config” file, with the desired size in the “value” attribute:

<add key=”LazyLoadingChunkSize” value=”50”/>
The default value is 50.

Setting the service time out values for all remote service references
(Windows only)

To change the service timeout value for all remote service references, add the

following key to the <appSettings> section of the “Quark Publishing Platform

Client.exe.config” file, with the desired time (in seconds) in the “value” attribute:

<add key=”ServiceTimeoutInSeconds” value=”0”/>
The default value is 0. Use the default value specified in the Platform Server
configuration.
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Setting the service timeout value for publishing service (Windows only)

To change service timeout value for the publishing service, add the following key to

the <appSettings> section of the “Quark Publishing Platform Client.exe.config”

file, with the desired time (in seconds) in the “value” attribute:

<add key=”PublishingServiceTimeoutInSeconds” value=”600”/>
The default value is 600. A value of 0 denotes that the settings specified by
ServiceTimeoutInSeconds will be in effect.

Specify the font size of the copy tasting row (Windows only)

To change the font size used for the copy tasting row, add the following key to the

<appSettings> section of the “Quark Publishing Platform Client.exe.config” file,

with the desired font size in the “value” attribute:

<add key=”CopyTastingRowFontSize” value=”25”/>

Specify the icon for a file extension (Windows only)

To associate an icon with a specified file extension, add the following key to the

<appSettings> section of the “Quark Publishing Platform Client.exe.config” file,

with the path to the desired icon in the “value” attribute:

<add key=”icon_<file extension>” value=”Path of icon”/>
The key specifies the “file extension” and the value specifies the file path.

Controlling password retention (macOS only)

You can configure Quark Publishing Platform clients to remember the user name

but not the user password between logins. To configure this option:

For Quark Publishing Platform Client, open the file•
~/Library/Preferences/Quark/QPP/[QPP Framework
Version]/com.quark.qpp.client.{Application}.config.plist, locate

the following text, and change <false/> to <true/>:

<key>RememberPassword</key>
<false/>

For QuarkXPress for macOS, open the file•
~/Library/Preferences/Quark/QPP/[QPP Framework
Version]/com.quark.qpp.client.{Application}.config.plist, locate

the following text, and change <false/> to <true/>:

<key>RememberPassword</key>
<false/>

For QuarkCopyDesk for macOS, open the file•
~/Library/Preferences/Quark/QPP/[QPP Framework
Version]/com.quark.qpp.client.{Application}.config.plist, locate

the following text, and change <false/> to <true/>:

<key>RememberPassword</key>
<false/>
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Using Mac clients with a proxy server

If you want macOS clients outside of the firewall to be able to connect to Quark

Publishing Platform Server through a proxy server, do the following:

For Quark Publishing Platform Client, open the ~/Library/Application•
Support/Quark/QPP/[QPP Framework
Version]/com.quark.qpp.client.{Application}.config.plist file,

locate the following text, and change <false/> to <true/>:

<key>UseProxy</key>
<false/>

For QuarkXPress for macOS, open the ~/Library/Application•
Support/Quark/QPP/[QPP Framework
Version]/com.quark.qpp.client.{Application}.config.plist file,

locate the following text, and change <false/> to <true/>:

<key>UseProxy</key>
<false/>

For QuarkCopyDesk for macOS, open the ~/Library/Application•
Support/Quark/QPP/[QPP Framework
Version]/com.quark.qpp.client.{Application}.config.plist file,

locate the following text, and change <false/> to <true/>:

<key>UseProxy</key>
<false/>

Using Windows clients with a proxy server

To use a Windows client with a proxy server:

Open the “[application name].exe.config” file and locate the following line:1.

<!— <add key=”ProxyAddress”
value=”http://<proxyname>:<portnumber>”/> —>
Uncomment the line and insert the appropriate proxy details.2.

Save and close the file.3.

Mirroring the collection hierarchy on Check Out/Get

By default, Quark Publishing Platform clients mirror the collection hierarchy on

their local drive when they check out or get an asset. However, you can change this

option.

Turning off collection mirroring: macOS

To turn off collection mirroring on macOS:

For Quark Publishing Platform Client, open the file1.
~/Library/Preferences/Quark/QPP/[QPP Framework
Version]/com.quark.qpp.client.Quark Publishing Platform
Client.config.plist, locate the following text, and change <true/> to

<false/>:

<key>MirrorCollectionHierarchy</key>
<true/>
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For QuarkXPress, open the file ~/Library/Preferences/Quark/QPP/[QPP2.
Framework
Version]/com.quark.qpp.client.QuarkXPress.config.plist, locate

the following text, and change <true/> to <false/>:

<key>MirrorCollectionHierarchy</key>
<true/>
For QuarkCopyDesk, open the file3.
~/Library/Preferences/Quark/QPP/[QPP Framework
Version]/com.quark.qpp.client.QuarkCopyDesk.plist, locate the

following text, and change <true/> to <false/>:

<key>MirrorCollectionHierarchy</key>
<true/>

Turning off collection mirroring: Windows

To turn off collection mirroring on Windows:

For Quark Publishing Platform Client, open the “Quark Publishing Platform1.

Client.exe.config” file, locate the following key, and set value to 0.

<add key=”MirrorCollectionHierarchy” value=”1”/>
For QuarkXPress, open the “Quark.QPP.Client.config” file, locate the following2.

key, and set value to 0.

<add key=”MirrorCollectionHierarchy” value=”1”/>
For QuarkCopyDesk, open the “Quark.QPP.Client.config” file, locate the3.

following key, and set value to 0.

<add key=”MirrorCollectionHierarchy” value=”1”/>

Configuring publishing channels

You can control which publishing channels are supported by Quark Publishing

Platform.

Configuring publishing channels: macOS

To configure publishing channels on macOS:

For all Mac OS clients, open the following file:1.

~/Library/Preferences/Quark/QPP/[QPP
Framework
Version]/com.quark.qpp.publishing.preferences.v7.plist
Locate the following key, which specifies the list of publishing channels that are2.

honored by the client, and add or remove channels.

<key>EnabledPublishingChannels</key>
<array>

<string>qxpPdf</string>
<string>qxpEpub</string>
<string>qxpAppStudio</string>
<string>qxpAppStudioPackage</string>
<string>busDocPdf</string>
<string>busDocHtml</string>
<string>busDocQxp</string>
<string>busDocAppStudio</string>
<string>busDocAppStudioPackage</string>
<string>ditaDocPdf</string>
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<string>ditaDocWordRTF</string>
<string>ditaDocHtml</string>
<string>collectBusdocForOutput</string>
<string>collectDitaForOutput</string>
<string>smartDocHtml5Publication</string>
<string>busDocHtml5Publication</string>
<string>visioDocPdf</string>
<string>fetchVisioPage</string>
<string>fetchPowerPointSlide</string>

</array>
Add or remove the desired publishing channels.3.

Configuring publishing channels: Windows

To configure publishing channels on Windows:

For Quark Publishing Platform Client, open the “Quark Publishing Platform1.

Client.exe.config” file and locate the following key, which specifies the list of

publishing channels that are honored by the client.

<add key=”EnabledPublishingChannels” 
value=”qxpPdf,qxpEpub,qxpAppStudio,qxpAppStudioPackage,
busDocPdf, busDocHtml,busDocQxp,busDocAppStudio, 
busDocAppStudioPackage, ditaDocPdf,ditaDocWordRTF,ditaDocHtml,
qxpAppStudio, collectBusdocForOutput, collectDitaForOutput,
smartDocHtml5Publication,
busDocHtml5Publication, visioDocPdf, fetchVisioPage,
fetchPowerPointSlide”/>
Add or remove the desired publishing channels.2.

For QuarkXPress and QuarkCopyDesk, open the “Quark.QPP.Client.config” file3.

and make the same changes.

Configuring Delivery Channels

You can control which delivery channels are supported by Quark Publishing

Platform.

Configuring delivery channels: macOS

To configure delivery channels on macOS:

For all macOS clients, open the following file:1.

~/Library/Preferences/Quark/QPP/[QPP
Framework
Version]/com.quark.qpp.publishing.preferences.v5.plist

Locate the following lines:2.

<key>EnableDeliveryChannels</key>
<false/>
Change the <false/> element to <true/>3.

Locate the following key, which specifies the list of delivery channels that are4.

honored by the client:

<key>EnabledDeliveryChannels</key>
<array>
<string>checkInToSharepoint</string>
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<string>checkInToFileNet</string>
<string>sendEmail</string>
<string>checkInToDocumentum</string>

<string>sendToFileSystem</string>
<string>sendToFTPServer</string>
</array>
Add or remove the desired delivery channels.5.

Configuring delivery channels: Windows

To configure publishing channels on Windows:

For all Windows clients, open the following file:1.

~application name.exe.config

Locate the following lines:2.

<add key =”EnableDeliveryChannels” value=”0”>
Change the 0 to a 1.3.

Locate the following line, which specifies the list of delivery channels that are4.

honored by the client:

<add key=”EnabledDeliveryChannels”
value=”checkInToSharepoint,

checkInToFileNet,
sendEmail,
checkInToDocumentum,
sendToFTPServer,
sendToFileSystem”/>

Add or remove the desired delivery channels.5.

Setting preferences for Quark XML Author for Platform

The following settings are also applicable for the Platform Adapter for Microsoft
Office.

Setting the Check-out location

To set the Check-out location preference, use the CheckOutLocation key under

the <appSettings> section of the “Quark.CMS.Adapters.config” file. This sets the

initial preference on first launch of the application.

To change the Check-out location Go to File > Preferences > General and browse

to the location you want to set as the Check-out location.

This preference can be reset in this way:

Reset to Default : User can change the preferences by changing the•

CheckOutLocation key under the appSettings section of the

“Quark.CMS.Adapters.config” file and using the Advanced > Reset to
Default feature.
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Setting the file deletion preference on Save and Close

To set the File Deletion preference, use the FileDeletionOption key under the

<appSettings> section of the “Quark.CMS.Adapters.config” file. This sets the

initial preference on first launch of the application.

To change the file deletion preference Go to File > Preferences > General and select

one of the following values:

Delete without Warning1.

Never Allow Deletion2.

Ask Before Deletion3.

This preference can be reset in the following way:

Reset to Default : User can change the preferences by changing the•

FileDeletionOption key under the appSettings section of the

“Quark.CMS.Adapters.config” file and using the Advanced > Reset to
Default feature.

Setting the quick search preference

To set the Quick Search preference, use the QuickSearchOption key under the

<appSettings> section of the “Quark.CMS.Adapters.config” file. This sets the

initial preference on first launch of the application.

To change the quick search preference, go to File > Preferences > Search and select

one of the following values:

Name1.

Content2.

Name and Content3.

This preference can be reset in the following way:

Reset to Default: User can change the preferences by changing the•

QuickSearchOption key under the appSettings section of the

“Quark.CMS.Adapters.config” file and using the Advanced > Reset to
Default feature.

Setting the display revision comments preference on Save and Close

To set the Display Revision Comments preference, use the

RevisionCommentsDisplayOption key under the <appSettings> section of

the “Quark.CMS.Adapters.config” file. This sets the initial preference on first launch

of the application.

To change the file deletion preference Go to File > Preferences > Search and select

one of the following values:

Always1.

Never2.

New Assignments Only3.
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This preference can be reset in the following way:

Reset to Default: User can change the preferences by changing the•

RevisionCommentsDisplayOption key under the appSettings section of the

“Quark.CMS.Adapters.config” file and using the Advanced > Reset to
Default feature.

Configuring the Platform Adapters for Microsoft Office components for web
sharing

The web sharing configuration is only recommended for standalone server
installations and not for external web container deployments or EAR based

deployments. If web sharing configuration is required under those scenarios you

will need to work with Quark Technical Support.

This chapter gives instruction on installing the following Microsoft Office

components:

Quark Publishing Platform Adapter for Microsoft Office - Word•

Quark Publishing Platform Adapter for Microsoft Office - Excel•

Quark Publishing Platform Adapter for Microsoft Office - PowerPoint•

The deployment location will be in the “Quark Publishing Platform Server”

webapps folder on the Platform server machine.

The following steps need to be completed before installing any of the components:

Copy and extract the archive “Platform<version and1.

build>_Adapter_for_Office.zip”.

From the extracted archive, copy/overwrite all files from the folder2.

“webapps\ROOT” to the “Quark Publishing Platform Server\webapps\ROOT”

folder.

Copy the contents of the folder “webapps\clientinstallers” to the “Quark3.

Publishing Platform Server\webapps\clientinstallers” folder.

Then perform the steps in the following sections to install the individual

components.

Configuring the Quark Publishing Platform Adapter for Microsoft Office
- Word

To install the Platform Adapter for Microsoft Word:

Extract the contents of the archive “Word Adapter.zip” file from the1.

webapps\clientinstallers folder on the Platform server machine to the

webapps\clientinstallers\Word Adapter folder.

Open the “ConfigureAdapter.bat” file located in the clientinstallers/Word2.

Adapter folder.

Update the HostName/IP and the Port, and then run the Batch file.3.

Configuring the Quark Publishing Platform Adapter for Microsoft Office
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- Excel

To install the Platform Adapter for Microsoft Excel:

Extract the contents of the archive “Excel Adapter.zip” file from the1.

webapps\clientinstallers folder on the Platform server machine to the

webapps\clientinstallers\Excel Adapter folder.

Open the “ConfigureAdapter.bat” file located in the2.

clientinstallers/Excel Adapter folder.

Update the HostName/IP and the Port, and then run the Batch file.3.

Configuring the Quark Publishing Platform Adapter for Microsoft Office
- PowerPoint

To install the Platform Adapter for Microsoft Excel:

Extract the contents of the archive “PowerPoint Adapter.zip” file from the1.

webapps\clientinstallers folder on the Platform server machine to the

webapps\clientinstallers\PowerPoint Adapter folder.

Open the “ConfigureAdapter.bat” file located in the2.

clientinstallers/PowerPoint Adapter folder.

Update the HostName/IP and the Port, and then run the Batch file.3.

Update published ClickOnce deployments

To update a published ClickOnce deployment package, use the Manifest Generation

and Editing Tool (mage.exe), which is installed with Microsoft Visual Studio.

Update the package and the application manifest

Go to Application1.

Files\Quark.CMSAdapters.Office.<component>_%HighestVersion% and

delete the “Quark.CMSAdapters.Office.<component>.vsto” file. ,where

component is Word, Excel or PowerPoint.

Make updates to the configuration files as required.2.

Run the Mage tool. Using the Visual Studio Command Prompt from Visual3.

Studio Tools, type mage.exe.

in Mage, open the application manifest4.

“Quark.CMSAdapters.Office.<component>.dll.manifest” in the \Application
Files\App_%HighestVersion%\folder.
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Select Files and check the When populating add the .deploy extension to any5.

file that does not have it option. Then click on the Populate button, and save

the file by either clicking Save or File > Save.

Click Yes in the Validation dialog.6.
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Provide the certificate file location path and its password (if any) by selecting7.

the Sign with certificate file option. Click OK.

Update VSTO

To update the “Quark.CMSAdapters.Office.<component>.vsto” present in the1.

package folder use the following command:

mage -Update
“<path>\Quark.CMSAdapters.Office.<component>.vsto” -
AppManifest
“<path>\Quark.CMSAdapters.Office.<component>.dll.manifest” -
CertFile “<certificate Path>\<certificate>.pfx” -Password
“<password>”

Copy the “Quark.CMSAdapters.Office.Word.vsto” file from the package folder to2.

\Application Files\App_%HighestVersion%\.

Manual configuration for QuarkXPress and QuarkCopyDesk XTensions

The QuarkXPress and QuarkCopyDesk XTensions have xml based preferences stored

in the QPPXPressXT.xml and QPPCopyDeskXT.xml files in the application

preference folder.

In Windows, the QuarkXPress preference folder is located:
C:\Users\<username>\AppData\Local\Quark\QuarkXPress 2016 and the

QuarkCopyDesk preference folder is located: C:\Users\<user
name>\AppData\Local\Quark\QuarkCopyDesk 2016 

In macOS, the QuarkXPress preference folder is located:
/Volume/users/username/Library/Preferences/Quark/QuarkXPress 2016.

The QuarkCopyDesk preference folder is located:
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/Volume/users/username/Library/Preferences/Quark/QuarkCopyDesk
2016.

Most of the preferences are set using the user interface, but setting the location of

the Platform menu items is done manually.

To set the location of the Platform menu items:

Set the location attribute in the PlatformMenuItemsLocation node, under•

the <Basic> section of the “QPPXPressXT.xml” and “QPPCopyDeskXT.xml”

files. Set to one of the following values:

0 File Menu (Default Value)1.

1 Platform Menu2.

2 to show in both file and Platform Menu3.
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Managing backups and file storage

You choose the backup software and determine the backup intervals for your Quark

Publishing Platform database, your Quark Publishing Platform assets, and essential

files, such as your Quark® Job Jackets® files and script files. Quark recommends

synchronizing backups for your database, assets, and essential files to avoid

inconsistency if you have to restore a backup. Quark also recommends periodic

testing to verify that your backups can be restored successfully, if necessary.

If you move your asset repository, follow the instructions in “Moving Quark

Publishing Platform asset repository.”

Backing up Quark Publishing Platform Server

Quark recommends stopping Quark Publishing Platform Server before performing a

backup, but stopping Quark Publishing Platform Server is not required. Back up

your database, your assets, and essential files (such as your FTS index files) on a

separate storage device. Although you can back up your entire “Quark Publishing

Platform Server” folder, the most important folders include the following:

“conf” folder (contains system configuration files, including files edited•

manually after installation)

“index” folder (contains the Full Text Search index files)•

Backing up your database

The database contains all metadata for Quark Publishing Platform assets.

If you use a Microsoft® SQL database or an Oracle database, use the backup tools

and instructions provided with MS-SQL or Oracle.

Backing up assets

You specify the software and intervals for backing up your Quark Publishing

Platform asset repository.

Asset names are encrypted in the Quark Publishing Platform asset repository.

Backing up Index files (full text search)

Quark Publishing Platform Server indexes all files checked into the database so you

can perform a search within the text content of Quark Publishing Platform assets.

Quark Publishing Platform Server stores index information for full-text search
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operations in the “index” folder. The “index” folder is at the root level of your

Quark Publishing Platform Server folder and is the default location for the files

required for full-text indexes. See “Full text indexing configuration“ to learn how to

change the full-text index storage location by editing

“LuceneTextIndexingConfig.properties.” If you change the location, back up the

new location.

Restoring Quark Publishing Platform Server

If you do not have to restore your Quark Publishing Platform asset repositories, the

storage paths to the asset repositories will still be valid after you restore your Quark

Publishing Platform database. If you must restore your Quark Publishing Platform

asset repositories as well as your database, specify the updated storage location

according to the instructions in “Moving Quark Publishing Platform Asset Repository.”

For example, if the hard drive fails on the computer running Quark Publishing

Platform Server, your latest backup should be stored in a separate location. Re-install

Quark Publishing Platform Server according to the instructions in the Quark

Publishing Platform ReadMe. After you re-install Quark Publishing Platform Server,

make sure it is not running before you restore your database, assets, and other files.

Restoring Assets

Try to use the same path you used for the old asset repository. For example, if you

replace the hard drive on the computer running Quark Publishing Platform Server,

you can copy the asset repository backup to the same location. Even if you need a

new computer, try to have the same path (for example, C:\QPP_Assets).

If you can search for Quark Publishing Platform assets and you need to see the

encrypted file names, view the “File Path” attribute when your search is complete.

The master file and all asset revisions are stored in the same storage location. The

encrypted asset names follow the same pattern (for example, 34.1.1.1.JPG). The

first number in the encrypted name denotes the asset ID. The second number

identifies the version number, the third number identifies the rendition type for

previews, and the fourth number identifies the first page of the preview.

If you have to restore hardware, launch Quark Publishing Platform Client and re-
establish the link with one or more repositories defined in the Repository tab of the

Administration: Storage screen. Do not delete the storage repository and try to

create another one.

Restoring Quark Publishing Platform Server database

If you use a Microsoft SQL database or an Oracle database, use the restore tools and

instructions provided with MS-SQL or Oracle. When you re-install Quark Publishing

Platform Server, you can enter the correct MS-SQL or Oracle information during the

installation process.

Restoring Full Text Indexes

Restore the “index” folder in the location specified in the

“LuceneTextIndexingConfig.properties” file.
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Moving Quark Publishing Platform asset repository

If you move your Quark Publishing Platform asset repository, you can update the

asset repository path with Quark Publishing Platform Client. See “Configuring

storage options” in A Guide to Quark Publishing Platform for more information about

specifying asset storage.

To update the asset repository path:

In a Web browser, navigate to http://[server]:[port]/admin and log on1.

with administration privileges.

Display the Administration screen and click Storage. The Administration:2.

Storage screen displays.

Display the Repository tab, which includes one or more entries in the3.

Repository Name column.

Select a repository, and choose Edit > Edit Repository. A warning message4.

displays.

This warning displays when you edit an asset repository

Click Yes. The Edit Repository dialog box displays.5.

The Edit Repository dialog box

Enter a new location in the Location field.6.

Repeat steps 4–6 for every repository listed in the Repository tab.7.
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Legal notices

©2022 Quark Software Inc. and its licensors. All rights reserved.

Quark, the Quark logo, and Quark Publishing Platform are trademarks or registered 

trademarks of Quark Software Inc. and its affiliates in the U.S. and/or other 

countries. All other marks are the property of their respective owners.
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